
lecteur MP3
manuel d’utilisation

imaginez les possibilités
Merci d’avoir choisi cet appareil Samsung. 
Pour recevoir une assistance plus complète, 
veuillez enregistrer votre produit sur 

www.samsung.com/global/register

YP-P2



fonctionnalités de votre nouveau lecteur MP3
Elégant, intelligent, fi able et très pratique : votre nouveau lecteur MP3 est tout 
cela à la fois et plus encore! Sa technologie de pointe offre une qualité de son et 
d’image exceptionnelle. Vous ne pourrez plus vous passer de votre nouveau lecteur 
MP3, que ce soit pour pratiquer une activité physique, télécharger vos chansons 
préférées, regarder des vidéos ou même écouter la radio. Utilisez-le ne serait-ce 
qu’une seule fois et vous vous demanderez comment vous avez pu vivre sans!
TOTALEMENT MULTIMEDIA
Nous l’appelons “lecteur MP3”, mais il 
s’agit de bien plus que cela. Ce baladeur 
numérique est en effet capable de lire aussi 
bien de la musique que des vidéos, des 
images, du texte, ou bien même d’écouter la 
radio! La compatibilité Bluetooth 2.0 permet 
quant à elle de connecter des casques 
stéréo sans fi l Bluetooth pour écouter vos 
chansons en toute liberté.

LA NAVIGATION TACTILE !
L’écran tactile vous permet de naviguer dans 
les différents menus.

ECRAN COULEUR LCD
Des images aux couleurs vives peuvent être 
affi chées sur l’écran large LCD.

L'ALLIANCE PARFAITE DE LA FORME ET 
DU FOND
Le lecteur MP3 n’est pas seulement discret 
et élégant. Il est également facile à utiliser et 
à manipuler.

RECHERCHE RAPIDE !
Vous pouvez rechercher des fi chiers grâce 
à l’interface de navigation facile d’utilisation 
et parcourir les menus tout en écoutant de 
la musique.

ECOUTE PROLONGEE ET DUREE DE 
TELECHARGEMENT REDUITE !
Une batterie entièrement chargée permet 
de lire jusqu’à 35 heures de musique et 5 
heures de vidéo.
La durée de téléchargement a en outre été 
sensiblement réduite. Grâce au standard 
USB 2.0, le lecteur est bien plus rapide que 
les modèles utilisant le format USB 1.1.

UNE QUALITE D’ECOUTE EXCEPTIONNELLE
Votre nouveau lecteur MP3 intègre la 
technologie sonore exclusive DNSe™ 
(Digital Natural Sound engine) de Samsung, 
fonction permettant de fournir un son d’une 
pureté et d’une richesse incroyables pour un 
plaisir d’écoute inégalé.



consignes de sécurité
Signifi cation des icônes et symboles utilisés dans ce 
manuel d’utilisation :

AVERTISSEMENT
Indique un risque de blessure grave, voire mortelle.

ATTENTION

Indique un risque potentiel de blessure ou de dégât 
matériel.

ATTENTION

Pour diminuer les risques d’incendie, d’explosion, de décharge 
électrique ou de blessure lorsque vous utilisez le lecteur MP3, 
respectez les consignes de sécurité suivantes :

REMARQUE
Indique des conseils ou des pages auxquelles se référer 
afi n d’en savoir plus sur le fonctionnement du lecteur.

NE PAS tenter d’effectuer quoi que ce soit.

NE PAS démonter.

NE PAS toucher.

Respecter scrupuleusement les consignes.

Débrancher la fi che de la prise murale.

Appeler le service d’assistance technique pour obtenir de l’aide.

Ces symboles d’avertissement vous indiquent comment éviter de vous blesser 
et de blesser d’autres personnes. Veuillez respecter scrupuleusement les 
consignes. Après avoir lu ce chapitre, rangez ce mode d’emploi dans un endroit 
sûr afi n de pouvoir vous y référer ultérieurement.



consignes de sécurité
Ce manuel vous indique comment utiliser correctement votre nouveau
lecteur MP3. Lisez-le attentivement avant toute utilisation afi n d’éviter
d’endommager votre lecteur ou de vous blesser.
Portez particulièrement attention aux avertissements suivants :

PROTEGEZ-VOUS
Ne prenez pas l’initiative de démonter, réparer ou modifi er cet appareil 
vous-même.

Evitez de mouiller l’appareil ou de le faire tomber dans l’eau. Si une 
telle situation se produit malgré tout, n’allumez pas le lecteur car vous 
risqueriez de vous électrocuter. Contactez plutôt le service clientèle de 
Samsung le plus proche de chez vous.

N'utilisez pas les écouteurs lorsque vous conduisez une bicyclette, une 
automobile ou une moto.
Dans le cas contraire, vous risqueriez de provoquer un accident grave.
L’utilisation des écouteurs en marchant ou lorsque vous courrez, en particulier sur 
les passages piétons, peut se révéler très dangereuse.

Faites particulièrement attention lorsque le câble USB du lecteur n’est 
pas branché et pend dans le vide. 
La fi che USB possède des bords tranchants et risque de vous blesser.

Ne conservez pas l’appareil dans un endroit humide, poussiéreux ou 
couvert de suie ; vous risqueriez de provoquer un incendie ou une 
décharge électrique.

ATTENTION

AVERTISSEMENT

ATTENTION



PROTEGEZ-VOUS
L’utilisation prolongée des écouteurs ou du casque peut fortement réduire 
votre acuité auditive.
Si vous vous exposez à un volume sonore supérieur à 85 dB pendant une durée 
prolongée, votre ouïe sera irrémédiablement endommagée. Plus le son est élevé, plus 
votre acuité auditive diminue (le niveau sonore d’une conversation ordinaire est compris 
entre 50 et 60 dB alors que celui provenant d’une route est d’environ 80 dB). 
Il est fortement recommandé d’utiliser un volume sonore moyen (le volume moyen est 
habituellement inférieur de 2/3 au volume maximal).
Si vous ressentez des bourdonnements dans les oreilles, réduisez le 
volume ou n’utilisez plus les écouteurs ou le casque.

PROTEGEZ VOTRE LECTEUR MP3
Ne laissez pas l’appareil dans un lieu où la température excède 35°C 
(ex. : sauna ou voiture en stationnement).
Evitez tout choc brutal (ex. : chute).
Ne posez pas d’objets lourds sur l’appareil.
Empêchez que des particules externes ou de la poussière ne pénètrent 
dans l’appareil.
Ne posez jamais l’appareil à proximité d’objets émettant des ondes 
électromagnétiques.
Veillez à toujours enregistrer vos données les plus importantes. Samsung 
ne saurait être tenu pour responsable en cas de pertes de données.
Utilisez uniquement les accessoires fournis ou agréés par Samsung.
Evitez toute projection d’eau sur l’appareil. Ne nettoyez jamais l’appareil à l’aide 
de produits chimiques (ex. : benzène ou diluant) ; vous risqueriez de provoquer 
un incendie ou une décharge électrique ou d’en détériorer la surface.
Suivez attentivement ces instructions afi n d’éviter de vous blesser ou 
d’endommager le lecteur.
Nous vous conseillons d’imprimer ce mode d’emploi en couleur et de 
paramétrer l’option d’impression « Ajuster à la taille de la page » pour 
qu’il soit plus agréable à lire.

ATTENTION

REMARQUE

AVERTISSEMENT

ATTENTION
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fonctions de base
CONTENU
Votre nouveau lecteur MP3 est fourni avec les accessoires présentés ci-dessous. 
Si l’un de ces éléments ne se trouve pas dans l’emballage, contactez le service 
clientèle de Samsung.

Lecteur Ecouteurs Câble USB CD
d’installation

Support facile

Il se peut que les accessoires livrés avec votre appareil soient légèrement 
différents de ceux illustrés.

Utilisation du support facile
Fixez le lecteur au support facile sur une surface plane. En procédant 
ainsi, vous pouvez profi ter de la vidéo sans tenir le lecteur.

Il ne s’agit pas d’un support fi xe. Aussi, veillez à ne pas l’agiter.
REMARQUE
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Crochet du support facile
Fixation de la dragonne du support facile

VOTRE LECTEUR MP3

Ecran tactile

Témoin lumineux
Le témoin lumineux s’allume en 
rouge lorsque la batterie est en 
cours de chargement.
Une fois terminé, il devient vert.

 Bouton d’augmentation du volume
Appuyez sur le bouton pour augmenter le 
volume.

 Bouton de réduction du volume
Appuyez sur le bouton pour diminuer le 
volume.

Bouton de 
réinitialisation
Si un dysfonctionnement 
du lecteur survient, 
appuyez sur le bouton 
de réinitialisation à l’aide 
d’un objet pointu afi n de 
réinitialiser le système.
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VOTRE LECTEUR MP3 (Suite)

Bouton Hold (Verrouillage) 
Faites glisser ce bouton dans le sens indiqué
par la fl èche pour verrouiller les touches.

Port USB

Bouton Alimentation et Lecture/Pause 
Appuyez sur le bouton pour lancer la lecture ou la 
mettre en pause.
Pour éteindre/allumer le lecteur, appuyez 
brièvement sur ce bouton.

Prise pour écouteurs

Ecouteurs
Pour votre 
confort, les lettres 
L (écouteur 
gauche) et R 
(écouteur droit) 
sont gravées sur 
chaque écouteur. 
Ce cordon sert 
également
d’antenne radio.
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ECRANS
Vidéo

1
Témoin Bluetooth/
verrouillage/alarme 7

Affi chage Lecture/Pause 
et Recherche

2 Etat de la batterie 8 Témoin du mode Vidéo

3 Heure actuelle 9 Barre d'état de la lecture

4
Durée de lecture actuelle/
totale 10 Icône de retour en arrière

5 Nom du fi chier 11 Icône de menu

6
Icône Lecture/Pause et 
Recherche
Les représentations à l’écran fi gurent à titre indicatif uniquement. 
L’écran réel de votre appareil peut être différent.
Les informations et les icônes de la lecture de la vidéo actuelle 
disparaissent rapidement. Appuyez légèrement sur l’écran pour affi cher à 
nouveau les informations relatives à la lecture de la vidéo et les icônes.

Video Track 1

11

3

1

28

7

4

6

9

10

5

REMARQUE
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ECRANS (Suite)
Musique

1
Témoin Bluetooth/verrouillage/
alarme

2 Heure actuelle

3 Etat de la batterie

4 Témoin de lecture de la plage en 
cours/du nombre total de plages

5 Ecran Lect mus.

6 Barre d'état de la lecture

7 Durée de lecture actuelle/totale

8
Icône Lecture/Pause et 
Recherche

9 Icône DNSe

10
Affi chage Lecture/Pause et 
Recherche

11 Témoin du mode Musique

12 Témoin du menu associé

13 Titre de la plage

14 Témoin du mode DNSe

15 Témoin du mode Lecture

16 Icône de retour en arrière

17 Icône de menu

Audio Track 1

Songs 1/52
3

4

1

2

10

12

11

13

5

14

15
6

7

8

916

17
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ECRANS (Suite)
Image

1
Témoin Bluetooth/verrouillage/
alarme

2 Heure actuelle

3 Etat de la batterie

4 Témoin du fi chier en cours/du 
nombre total de fi chiers

5 Icône de l’image suivante

6 Icône de zoom

7
Etat de la lecture des fi chiers 
musicaux

8 Témoin du mode Image

9 Nom du fi chier

10 Icône de l’image précédente

11 Icône de retour en arrière

12 Icône de menu

Les informations et les icônes de l’affi chage de l’image actuelle 
disparaissent rapidement. Appuyez légèrement sur l’écran pour affi cher à 
nouveau les informations relatives à l’image et les icônes.
L’icône [ ,  ] de l’image précédente/suivante apparaît si vous appuyez 
une fois sur l’écran. Appuyer à nouveau dessus permet d’affi cher les 
informations concernant l’image et les icônes.

Picture image 1 8/17
3

4

1

2

7

9

8

510

611

12

REMARQUE

[Ecran d’affi chage de l’image]
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ECRANS (Suite)
Radio FM

1
Témoin Bluetooth/verrouillage/
alarme

2 Heure actuelle

3 Etat de la batterie

4 Affi chage Manuel/
Présélectionné

5 Icône du numéro préréglé

6 Témoin du mode Radio

7
Affi chage de la fréquence en 
cours (MHz)

8
Affi chage de la barre de 
fréquence radio

9 Icône de retour en arrière

10 Icône de menu

FM Radio
3

1

2

5

8

9

10

4
7

6
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UTILISATION DE L’ECRAN TACTILE
Appuyez légèrement sur l’écran tactile du bout du doigt.

N’exercez pas une pression excessive lorsque vous appuyez sur l’écran tactile car 
vous risqueriez de l’endommager.
Afi n de ne pas endommager l’écran tactile, utilisez uniquement vos doigts pour 
l’activer.
Veillez toujours à avoir les mains propres avant d’utiliser votre appareil.
N’utilisez jamais le pavé tactile mains gantées.
Il est possible que l’écran ne fonctionne pas si vous utilisez votre ongle ou un autre 
objet tel qu’un stylo à bille.

REMARQUE
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UTILISATION DE L’ECRAN TACTILE (Suite)
Vous pouvez faire avancer votre doigt dans quatre directions différentes (haut, 
bas, gauche et droite) selon la fonction. 
Ex. : Barre de progression de la lecture des fi chiers musicaux

Marche à suivre 1
Appuyez longuement sur la barre de 
progression de la lecture affi chée à l’écran 
et déplacez votre doigt sur le point souhaité 
avant de le relâcher.

La lecture reprend au point de relâchement.

Marche à suivre 2
Appuyez légèrement sur le point souhaité de 
la barre de progression de la lecture.
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UTILISATION DE L’ECRAN TACTILE (Suite)
Ex. : Image agrandie

Marche à suivre 3
Appuyez sur l’écran et faites glisser votre doigt dans la direction 
souhaitée avant de le relâcher comme illustré ci-dessous.

En mode Zoom, déplacez votre doigt dans la direction souhaitée. 
L’image se déplace et s’affi che selon cette direction.
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UTILISATION DE L’ECRAN TACTILE (Suite)
Ex. : Lecture du fi chier vidéo précédent/suivant

Marche à suivre 4
Faites glisser votre doigt vers la gauche ou vers la droite.

Gauche : Permet de passer au fi chier suivant (en fonction du réglage du trait 
horizontal. Reportez-vous à la page 44).

Droite : Permet de passer au fi chier précédent (en fonction du réglage du trait 
horizontal. Reportez-vous à la page 44).

Video Track 1
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CHARGEMENT DE LA BATTERIE
Chargez-la avant d’utiliser votre lecteur pour la première fois ou lorsque vous 
ne l’avez pas utilisé pendant une période prolongée.
La batterie de votre lecteur MP3 se charge complètement en environ quatre 
heures et demie, mais cette durée peut varier en fonction de la confi guration de 
votre ordinateur.

1. Branchez l’extrémité la plus large du câble USB sur le port de connexion 
USB situé dans la partie inférieure du lecteur.

2. Branchez le câble USB sur le port USB ( ) de votre ordinateur.
Le témoin lumineux s’allume en rouge lorsque la batterie est en cours de chargement. 
Une fois terminé, il devient vert.

1

2

Témoin lumineux
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ENTRETIEN DE LA BATTERIE
La batterie durera plus longtemps si vous respectez ces consignes d’entretien 
et de rangement.
• Rechargez et rangez l’appareil dans un lieu où la température est comprise 

entre 5°C et 35°C.
• Evitez de surcharger la batterie (12 heures au maximum). Charger ou décharger 

la batterie à des fréquences trop rapprochées peut réduire sa durée de vie. 
• Comme pour tout autre produit de consommation, la durée de vie de la 

batterie raccourcit progressivement avec le temps.
Si vous rechargez le lecteur via un ordinateur portable, assurez-vous que la batterie du 
portable est entièrement chargée ou que l’ordinateur est lui-même relié à une prise secteur.
La batterie ne se charge pas lorsque l’ordinateur est en mode Veille ou lorsque le 
matériel est retiré en toute sécurité.

MISE SOUS ET HORS TENSION DE L’APPAREIL
Mise sous tension de l’appareil
Appuyez longuement sur le bouton .

L’appareil s’allume.

Mise hors tension de l’appareil
Appuyez longuement sur le bouton .

L’appareil s’éteint.

L’appareil s’éteint automatiquement lorsque aucun des 
boutons n’est actionné pendant une durée prédéfi nie en mode 
Pause. La durée par défaut de <Auto Power Off> (Extinction 
auto) est de 1 minute, mais vous pouvez la modifi er. 
Consultez la page 33 pour plus d’informations.
Pour utiliser <Cosmos> (Cosmos) dans le menu principal, 
reportez-vous à la page 25.

REMARQUE

REMARQUE
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LECTURE D’UN FICHIER VIDEO
Téléchargez des fi chiers vidéo sur votre nouveau lecteur MP3 à l’aide de 
Samsung Media Studio. Pour en savoir plus sur Samsung Media Studio, 
consultez la page 37.
1. Appuyez légèrement sur l’icône  située sur 

l’écran du menu principal.
La liste des vidéos s'affi che.

2. Sélectionnez un fi chier vidéo à lire et appuyez 
dessus.

La lecture du fi chier vidéo sélectionné démarre 
horizontalement.

Appuyez sur l’icône [ ] pour revenir à l’écran précédent. 
Appuyez longuement sur l’icône [ ] pour accéder à l’écran du menu principal.

CONTROLE DU VOLUME
Vous pouvez régler le volume lorsque le fi chier est arrêté ou en cours de lecture.

Marche à suivre 1
Appuyez sur le bouton  , .

La barre de réglage du volume apparaît.
La plage de réglage du volume est comprise 
entre 0 et 30.
Appuyez sur le bouton pour augmenter 
le volume ou sur le bouton

 pour le diminuer.

Marche à suivre 2
Faites glisser votre doigt vers le haut ou vers le bas en partant de la 
moitié droite de l’écran.

La barre de réglage du volume apparaît.
Faire glisser le doigt vers le haut permet d’augmenter le volume et vers le bas 
de le diminuer.

REMARQUE

Video Track 1
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VERROUILLAGE DES BOUTONS
La fonction Verrouillage permet de verrouiller tous les boutons et les icônes 
du lecteur MP3 ; ainsi, si vous appuyez sur une touche par mégarde lors de la 
lecture d’un fi chier, celle-ci ne sera pas interrompue.
1. Faites glisser le commutateur dans

le sens de la fl èche.
2. Faites glisser le commutateur dans le 

sens opposé à celui indiqué par la fl èche pour 
désactiver cette fonction.

RECHERCHE DE FICHIERS A L’AIDE DU 
« Dossier Navigateur »
Recherchez des fi chiers en toute simplicité grâce la fonction <File Browser>
(Dossier Navigateur).
1. Appuyez sur l’icône  située sur l’écran du menu 

principal
La liste des dossiers <File Browser> (Dossier Navigateur) 
contenant des fi chiers vidéo, des fi chiers musicaux, des listes de 
lecture, des images, des listes de diffusion et des textes apparaît.

2. Sélectionnez le dossier souhaité.
3. Appuyez légèrement sur le dossier sélectionné pour 

affi cher la liste de fi chiers.
Appuyez sur l’icône [ ] pour revenir à l’écran précédent.

4. Sélectionnez le fi chier souhaité.
5. Appuyez légèrement sur le fi chier sélectionné.

La lecture du fi chier démarre.

Video Track 1

Video

Music

Playlists

Pictures

Datacasts

Texts

File Browser 1/6
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MODIFICATION DES REGLAGES ET DES PREFERENCES
Votre lecteur MP3 comprend des réglages et des préférences défi nis par défaut, 
mais vous pouvez les modifi er selon votre goût afi n de personnaliser votre lecteur.

Appuyez sur l’icône [ ] pour revenir à l’écran précédent.
Appuyez longuement sur l’icône [ ] pour accéder à l’écran du menu principal.

Réglages du style du menu
Vous pouvez modifi er l’aspect et la police du menu et supprimer l’image 
de fond d’écran du menu principal.
1. Appuyez sur l’icône située sur l’écran du 

menu principal
Le menu <Settings> (Paramètres) s’affi che.

2. Sélectionnez <Menu Style> (Style du menu) et 
appuyez dessus.

Le menu <Menu Style> (Style du menu) s’affi che.

3. Appuyez sur le menu souhaité.
4. Réglez les options souhaitées et appuyez sur <OK>.

Options de réglage du style du menu
Menu Design (Aspect du menu) : Vous pouvez modifi er le style de l’écran du 
menu principal. Choisissez entre <Cosmos> (Cosmos), <Matrix> (Matrice) et 
<My Skin> (Mon habillage). Reportez-vous aux pages 25 et 26.
Font (Police) : Vous pouvez modifi er le type de police du menu. 3 types de 
police sont proposés. Il est possible que pour certaines langues de menu, 
l’option <Font> (Police) est désactivé.
Reset My Skin (Réinitialiser mon habillage) : Permet d’initialiser l’image de 
fond de l’écran tactile par l’image par défaut.

Si l’écran <Settings> (Paramètres) est ouvert et que vous n’appuyez sur 
aucun bouton pendant environ 1 minute, les réglages non sauvegardés 
seront perdus et les précédents s’appliqueront automatiquement.

REMARQUE

REMARQUE

Settings

Menu Style
Sound

Display

Language

Time

System
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Utilisation du menu Cosmos
Marche à suivre 1
Placez votre doigt sur l’écran tactile et faites-le glisser vers le haut ou 
vers le bas. Appuyez légèrement sur l’icône du menu principal souhaité.

Marche à suivre 2
Placez votre doigt sur un espace vide de l’écran tactile et tracez de petits 
cercles. Appuyez légèrement sur l’icône du menu principal souhaité.

Menu <Cosmos> (Cosmos)
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Utilisation du menu Matrice
Appuyez légèrement sur l’icône du menu principal souhaité.

Utilisation du menu Mon habillage
Placez votre doigt sur l’écran tactile et faites défi ler puis relâchez vers la 
gauche ou vers la droite en déplaçant la pointe de votre doigt. Appuyez 
légèrement sur l’icône du menu principal souhaité.

Menu <Matrix> (Matrice)

Menu <My Skin> (Mon habillage)
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglages du son
Vous pouvez régler l’égaliseur principal, le signal 
sonore et l’intensité du volume sonore.
1. Appuyez sur l’icône située sur l’écran du 

menu principal
Le menu <Settings> (Paramètres) s’affi che.

2. Sélectionnez <Sound> (Son) et appuyez dessus.
Le menu <Sound> (Son) s’affi che.

3. Appuyez sur le menu souhaité.
4. Réglez les options souhaitées et appuyez sur 

<OK>.

Options de réglage du son
Master EQ (EG princ.) : Vous pouvez optimiser les réglages du son.
Appuyez légèrement sur l’icône [ , ] pour sélectionner la fréquence que vous 
souhaitez paramétrer. Les fréquences paramétrables sont <60Hz> , <150Hz>, 
<400Hz>, <1.1KHz> (1,1KHz), <3.5KHz> (3,5KHz), <8KHz> et <14KHz>. 
Appuyez sur l’icône [ , ] pour régler le niveau de la fréquence sélectionnée, 
puis sur <OK>.
Beep Sound (Signal sonore) : Permet d’activer ou de désactiver l’émission 
d’un signal sonore lors des opérations effectuées sur l'écran tactile.
Choisissez entre <Off> (Arrêt) et <On> (Marche).
Volume Limit (Limitation du volume) : Vous pouvez éviter l’apparition de 
troubles auditifs en réglant l’intensité du volume sonore lors de l’utilisation des 
écouteurs. l’option <On> (Marche) fi xe le niveau maximal du volume à 15. Le niveau 
maximal du volume lorsque la limite est réglée sur <Off> (Arrêt) est de 30.Même si 
vous avez sélectionné <Off> (Arrêt), le volume reviendra au niveau 15 lorsque vous 
rallumerez le lecteur afi n de vous éviter toute lésion du système auditif.

Vous ne pouvez pas régler l’option <Master EQ> (EG princ.) lorsque le 
lecteur est connecté aux écouteurs stéréo Bluetooth.

Settings

Menu Style

Sound

Display

Language

Time

System

REMARQUE
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglages de l’affi chage
Modifi ez le temps de mise en veille de l’affi chage et la luminosité de 
votre écran.
1. Appuyez sur l’icône située sur l’écran du 

menu principal
Le menu <Settings> (Paramètres) s’affi che.

2. Sélectionnez <Display> (Affi cher) et appuyez 
dessus.

Le menu <Display> (Affi cher) s’affi che.

3. Appuyez sur le menu souhaité.
4. Réglez les options souhaitées et appuyez sur 

<OK>.

Options de réglage de l’affi chage
Display Off (Affi ch. Désactivé) : Si aucun bouton ou aucune icône 
n’est actionné(e) pendant la durée défi nie plus bas, l’écran tactile s’éteint 
automatiquement. Choisissez entre <15sec>, <30sec>, <1min>, <3min>, 
<5min> et <Always On> (Toujours allumé). Pour rallumer l’écran, il vous suffi t 
d’appuyer sur n’importe quel bouton. 
Brightness (Luminosité) : Vous pouvez régler la luminosité de l’écran. 
Sélectionnez un niveau <0-10>, où 10 est le plus lumineux.

Settings

Menu Style

Sound

Display
Language

Time

System
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglages de la langue
De nombreuses langues sont disponibles pour l’affi chage des menus 
de votre nouveau lecteur MP3. Vous pouvez changer facilement de 
préférence de langue.
1. Appuyez sur l’icône située sur l’écran du 

menu principal
Le menu <Settings> (Paramètres) s’affi che.

2. Sélectionnez <Language> (Langue (Language)) 
et appuyez dessus.

Le menu <Language> (Langue (Language)) s’affi che.

3. Appuyez sur le menu souhaité.
4. Réglez les options souhaitées et appuyez sur 

<OK>.

Settings

Menu Style

Sound

Display

Language
Time

System
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Options de réglage de la langue

Menu (Menu): Permet de régler la langue du menu. Appuyez sur l’icône [  ,  ] 
pour revenir à la page précédente/aller à la page suivante.
Options disponibles <English>, <한국어>, <Français>, <Deutsch>, 
<Italiano>, <日本語>, < >, < >, <Español>, < >,
<Magyar>, <Nederlands>, <Polski>, <Português>, <Svenska>, < >,
< eština>, < >, <Türkçe>, <Norsk>, <Dansk>, <Suomi>, <Español 
(Sudamérica)>, <Português (Brasil)>, <Indonesia>, <Ti ng Vi t>, <Bulgarian>, 
<Român >, < >, <Slovenš ina> et <Slovenský>.
Contents (Sommaire) : Vous permet de régler la langue dans laquelle les 
informations de suivi et le texte seront affi chés. Appuyez sur l’icône [  ,  ] 
pour revenir à la page précédente/aller à la page suivante. Options disponibles 
<English>, <Korean>, <French>, <German>, <Italian>, <Japanese>, <Simplifi ed 
Chinese>, <Tranditional Chinese>, <Spanish>, <Russian>, <Hungarian>, 
<Dutch>, <Polish>, <Portuguese>, <Swedish>, <Thai>, <Finnish>, <Danish>, 
<Norwegian>, <Farsi>, <Afrikaans>, <Basque>, <Catalan>, <Czech>, 
<Estonian>, <Greek>, <Hrvatski>, <Icelandic>, <Rumanian>, <Slovak>, 
<Slovene>, <Turkish> et <Vietnamese>.

Les langues prises en charge peuvent être modifi ées ou ajoutées.
REMARQUE
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglages de l’heure
Cette option vous permet de régler la date/l’heure, le format de la date 
et même le fuseau horaire.
1. Appuyez sur l’icône située sur l’écran du 

menu principal
Le menu <Settings> (Paramètres) s’affi che.

2. Sélectionnez <Time> (Heure) et appuyez dessus.
Le menu <Time> (Heure) s’affi che.

3. Appuyez sur le menu souhaité.
4. Réglez les options souhaitées et appuyez sur 

<OK>.

Options de réglage de l’heure
Date/Time Set (Réglage heure/date) : Permet de régler la date et l’heure 
actuelles. Appuyez sur l’icône [ , ] pour régler chacun des éléments <Year> 
(Année), <Month> (Mois), <Day> (Jour), <Hour> (Heure), <Min> (Minute) et 
<AM/PM> (AM/PM).
Date Type (Type date) : Permet de régler le type d’affi chage de l’heure de 
l’horloge universelle. Choisissez entre <YY-MM-DD> (AA-MM-JJ), <MM-DD-
YY> (MM-JJ-AA) et <DD-MM-YY> (JJ-MM-AA).
Time Zone (Fuseau hr) : Permet de modifi er l’heure actuelle en sélectionnant 
le fuseau horaire d’une ville étrangère spécifi que. Vous devez commencer par 
régler le fuseau horaire pour pouvoir affi cher les informations relatives à l’heure 
mondiale. Reportez-vous à la page 86

Settings

Menu Style

Sound

Display
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Time

System



32 _ fonctions de base

MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglages du système
Sélectionnez le mode Veille, Début, Extinction auto ou Réglage par 
défaut adapté.
1. Appuyez sur l’icône située sur l’écran du 

menu principal
Le menu <Settings> (Paramètres) s’affi che.

2. Sélectionnez <System> (Système) et appuyez 
dessus.

Le menu <System> (Système) s’affi che.

3. Appuyez sur le menu souhaité.
4. Réglez les options souhaitées et appuyez sur 

<OK>.

Settings

Menu Style
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Time

System
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Options de réglage du système

Sleep (Veille) : Permet d’éteindre automatiquement l’appareil après 
l’écoulement de la durée préréglée. Options disponibles : <Off> (Arrêt), 
<15min>, <30min>, <60min>, <90min> ou <120min>.
Start Mode (Mode Début) : Permet de défi nir l’écran de démarrage affi ché lors de la 
mise sous tension du lecteur. Choisissez entre <Home> (Dom.) et <Last State> (Dernier 
état). Sélectionnez <Home> (Dom.) pour démarrer le système avec l’écran du menu 
principal et <Last State> (Dernier état) pour affi cher l’écran du dernier menu utilisé.
Auto Power Off (Extinction auto) : Permet d’éteindre automatiquement 
l’appareil lorsque aucun bouton n’est actionné avant l’écoulement de la durée 
prédéfi nie en mode Pause. choisissez entre <15sec>, <30sec>, <1min>, 
<3min>, <5min> et <Always On> (Toujours allumé).
Default Set (Réglage par défaut) : Permet de revenir aux valeurs de réglage 
par défaut. Options disponibles : <Yes> (Oui) ou <No> (Non). <Yes> (Oui) vous 
permet de réinitialiser l’appareil sur les réglages par défaut. <No> (Non) permet 
d’annuler les réglages par défaut.
Format (Formater) : Vous permet de formater la mémoire interne. Options 
disponibles : <Yes> (Oui) ou <No> (Non). Le réglage sur <Yes> (Oui) formate la 
mémoire interne et supprime tous les fi chiers du lecteur. En revanche, <No> (Non) ne 
lance pas le formatage de la mémoire interne. vérifi ez avant de lancer le formatage.
About (A propos de) : Permet de vérifi er la version du micrologiciel et la 
capacité de la mémoire.

Firmware (Firmware) - Affi che la version actuelle du micrologiciel.
Memory (Mémoire) - Indique la capacité restante de la mémoire. <Used> 

(Utilisé) indique la mémoire actuellement utilisée, 
<Remaining> (Mémoire restante) indique la capacité 
restante de la mémoire et <Total> indique la 
capacité totale de la mémoire.

A propos de la mémoire intégrée
1 Go=1 000,000,000 octets : la capacité réelle formatée peut être 
inférieure, car le micrologiciel interne en utilise une partie.

REMARQUE
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REINITIALISATION DU SYSTEME
Si votre lecteur MP3 ne s’allume pas, ne lance pas de lecture de fi chier ou n’est 
pas reconnu par votre ordinateur lorsque vous le branchez, il est préférable de 
réinitialiser le système.

Appuyez sur le bouton de réinitialisation 
situé sur la partie inférieure de l'appareil 
à l'aide d'un objet pointu, comme une 
agrafe.

Le système est réinitialisé.
La fonction Reset (Réinitialisation) ne permet 
pas de supprimer les renseignements de durée 
et les données enregistrées dans la mémoire 
intégrée.
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samsung media studio
L’application logicielle Samsung Media Studio est facile à utiliser et 
vous permet de classer vos fi chiers sur votre ordinateur. Une fois vos 
fi chiers classés et organisés dans Samsung Media Studio, vous pouvez 
les transférer rapidement vers votre lecteur MP3 sans avoir à faire des 
recherches sur l’ensemble de votre disque dur pour retrouver le bon 
fi chier.

CONFIGURATION REQUISE
Votre ordinateur doit être conforme aux spécifi cations minimales suivantes pour 
que vous puissiez installer et exécuter Samsung Media Studio :
• Pentium 500 MHz ou plus
• Port USB 2.0
• Windows XP Service Pack 2 ou ultérieur
• DirectX 9.0 ou version ultérieure
• 100 Mo d’espace libre sur le disque dur
• Lecteur de CD-Rom (2X ou plus)
• Windows Media Player 10 ou ultérieur
• Résolution 1024 X 768 ou plus
• Internet Explorer 6.0 ou version ultérieure
• Mémoire vive 512 Mo ou plus
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INSTALLATION DE SAMSUNG MEDIA STUDIO
Assurez-vous que le programme d’installation de <Samsung Media Studio> a été 
lancé sur le compte administrateur de votre ordinateur. 
Dans le cas contraire, <Samsung Media Studio> ne pourra pas être installé. Pour 
trouver le compte administrateur, veuillez vous référer au manuel d’utilisation de 
votre ordinateur.

1. Insérez le CD d’installation fourni avec le 
lecteur MP3 dans le lecteur CD-ROM de votre 
ordinateur.

2. Cliquez sur <Install now> (Installer 
maintenant).

3. Cliquez sur <NEXT> (SUIVANT).
L’installation de <Samsung Media Studio> démarre 
et une icône  s’affi che sur votre Bureau lorsque 
celle-ci est terminée. 

Next >

ATTENTION
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TRANSFERT DE FICHIERS VERS LE LECTEUR AVEC 
SAMSUNG MEDIA STUDIO
<Samsung Media Studio> vous permet de sélectionner et de classer des 
fi chiers et des dossiers avant de les transférer vers votre lecteur. Ainsi, le 
balayage des fi chiers sur votre lecteur MP3 devient plus facile et plus rapide. 
Le programme <Samsung Media Studio> est le moyen le plus simple de 
transmettre des fi chiers d’un ordinateur vers votre lecteur MP3.

1

2

1. Branchez l’extrémité la plus large du câble USB sur le port de connexion 
USB situé dans la partie inférieure du lecteur.

2. Branchez le câble USB sur le port USB ( ) de votre ordinateur.
Le message <USB connected> (USB connecté) s'affi che sur l'écran tactile du lecteur.
<Samsung Media Studio> démarre automatiquement lorsque vous branchez le lecteur 
sur votre ordinateur.
Si le programme ne démarre pas automatiquement, double-cliquez sur l’icône 
située sur le Bureau.

La technologie de reconnaissance musicale et les données relatives sont fournies 
par Gracenote et Gracenote CDDB®  Music Recognition ServiceSM.
CDDB est une marque déposée de Gracenote. Le logo et le logotype de Gracenote, 
le logo et le logotype Gracenote CDDB et le logo «Powered by Gracenote CDDB» 
sont des marques déposées de Gracenote. Music Recognition Service et MRS sont 
des marques de service de Gracenote.

REMARQUE



38 _ samsung media studio

TRANSFERT DE FICHIERS VERS LE LECTEUR AVEC 
SAMSUNG MEDIA STUDIO (Suite)
3. Cliquez sur l’icône correspondant au type 

de fi chier que vous souhaitez transférer.
Cliquez sur  pour affi cher la liste des fi chiers

   musicaux.

Cliquez sur  pour affi cher la liste des
fi chiers vidéo.

Cliquez sur  pour affi cher la liste des fi chiers
   image.

Cliquez sur  pour affi cher la liste des fi chiers 
etc. La liste des fi chiers ETC comprend des 
types de fi chiers (ex : TXT, etc) autres que les 
fi chiers musicaux, image et vidéo.

4. Cliquez sur <Add File> (Ajouter un fi chier) au bas 
de l’écran de <Samsung Media Studio>.

La fenêtre <Open> (Ouvrir) apparaît.

5. Sélectionnez les fi chiers que vous souhaitez 
ajouter et cliquez sur <Open> (Ouvrir).

Les fi chiers sont ajoutés sur la liste située sur la 
partie gauche de l’écran de <Samsung Media 
Studio>.

6. Dans la liste située à gauche, sélectionnez le 
fi chier à transférer.

7. Cliquez sur l’icône  .
Le fi chier sélectionné est transféré vers le lecteur.

5

[YP-P2 [MTP]]

Portable [YP-P2[MTP]]3

4

7

6 [YP-P2 [MTP]]

Portable [YP-P2[MTP]]
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TRANSFERT DE FICHIERS VERS LE LECTEUR AVEC 
SAMSUNG MEDIA STUDIO (Suite)

Ne débranchez jamais le câble USB durant le transfert de fi chiers ; vous risqueriez 
d’endommager le lecteur ou l’ordinateur.
Branchez le lecteur directement sur l’ordinateur plutôt que sur un Hub USB afi n 
d’éviter une mauvaise connexion.

Avant le transfert d’un fi chier vidéo vers le lecteur à l'aide du logiciel <Samsung 
Media Studio>, le fi chier est tout d’abord converti automatiquement au format SVI. 
La taille du fi chier est également réglée automatiquement. 
Avant le transfert d’un fi chier image vers le lecteur à l'aide du logiciel Samsung 
Media Studio, celui-ci est tout d’abord converti automatiquement au format JPG. La 
taille du fi chier est également réglée automatiquement.
Un fi chier image transféré vers le lecteur sans <Samsung Media Studio> peut être 
différent de l’image originale lors de son affi chage à l'écran.
Toutes les fonctions sont désactivées durant le branchement.
Si vous branchez le câble USB sur l’ordinateur alors que la batterie est faible, il 
faudra quelques minutes au lecteur pour se connecter à l’ordinateur.
Samsung Media Studio met à votre disposition une fonction Aide très complète. 
Si vous ne trouvez toujours pas de réponse à votre question concernant Samsung 
Media Studio, cliquez sur <MENU> --> <Aide> en haut du programme 
<Samsung Media Studio>.
Qu'est-ce que la fonctionnalité SVI ?
L'entrelacement Samsung Audio Video (SVI) est un nouveau format vidéo 
développé et contrôlé par Samsung.

ATTENTION

REMARQUE
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regarder une vidéo
Avant de démarrer -  Transfert de fi chiers vidéo vers le lecteur à l’aide de <Samsung 

Media Studio>. Reportez-vous à la page 37.
Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.

Appuyez sur l’icône [ ] pour revenir à l’écran précédent.
Appuyez longuement sur l’icône [ ] pour accéder à l’écran du menu principal.

1. Appuyez légèrement sur l’icône  située sur l’écran du 
menu principal

La liste des vidéos s'affi che.

2. Sélectionnez un fi chier vidéo à lire et appuyez dessus.
La lecture du fi chier vidéo sélectionné démarre horizontalement.

PAUSE
1. Appuyez sur l’icône [ ] pendant la lecture.

La lecture de la vidéo est interrompue.

2. Appuyez sur l’icône [ ] pour reprendre la lecture.
La lecture de la vidéo reprend à l’endroit où vous l'avez suspendue.

Les informations et les icônes de lecture de la vidéo actuelle disparaissent 
rapidement. Appuyez légèrement sur l’écran pour affi cher à nouveau les 
informations relatives à la lecture de la vidéo et les icônes.
Avant le transfert du fi chier vidéo vers le lecteur à l'aide du logiciel Samsung Media 
Studio, le fi chier est tout d’abord converti automatiquement au format SVI. La taille 
du fi chier est également réglée automatiquement.

REMARQUE

REMARQUE
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PASSER A UNE SEQUENCE SPECIFIQUE
Marche à suivre 1
1. En affi chage horizontal, appuyez 

longuement sur l’icône [ , ]
pendant la lecture.

Cette option vous permet de reculer ou 
d’avancer dans le fi chier vidéo en cours.

2. Relâchez l’icône une fois la position 
souhaitée atteinte.

La lecture de la vidéo démarre à partir 
de cette position.

Marche à suivre 2
Appuyez légèrement sur le point de la bande de progression de la 
lecture de la vidéo à partir duquel vous souhaitez démarrer la lecture.

La lecture de la vidéo démarre à partir du point sélectionné.

Faire glisser votre doigt vers la gauche ou la droite permet d’avancer ou de 
reculer en fonction du réglage du trait horizontal. Reportez-vous à la page 44.REMARQUE

Video Track 1
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LIRE LE FICHIER VIDEO PRECEDENT
Marche à suivre 1
Appuyez sur l’icône [ ] dans les 3 
secondes suivant le démarrage de la 
lecture de la vidéo en cours.
Appuyez deux fois sur l’icône [ ] après 
les 3 secondes suivant le démarrage de la 
lecture de la vidéo en cours.

Marche à suivre 2
Faites glisser votre doigt vers la droite.

Cette opération permet de revenir à la vidéo précédente.

LIRE LE FICHIER VIDEO SUIVANT
Marche à suivre 1
Appuyez sur l'icône [ ].

Marche à suivre 2
Faites glisser votre doigt vers la gauche.

Cette opération permet d'accéder à la 
vidéo suivante.

Video Track 1

Marche à suivre 2

Marche à suivre 2

Video Track 1
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UTILISATION DU MENU VIDEO
Réglage d'un signet
Lorsque vous ajoutez à vos favoris une scène spécifi que que vous 
souhaitez voir à nouveau, vous pouvez la regarder à tout moment.
1. Appuyez sur l’icône [ ] pour affi cher la 

scène souhaitée durant la lecture de la vidéo. 
Le menu <Video> (Vidéo) s’affi che.

2. Appuyez sur <Bookmark> (Signet).
Le menu <Bookmark> (Signet) s’affi che.

3. Appuyez sur <Add> (Ajouter).
La position de lecture/d’arrêt actuelle est 
défi nie comme signet.
Le symbole [ | ] apparaît dans la barre de progression de la lecture.

La fenêtre Réécrire apparaît si un signet a déjà été défi ni. Si vous sélectionnez <Yes> 
(Oui), le signet préalablement défi ni est supprimé et un nouveau signet est ajouté.
Un signet peut être défi ni pour chaque fi chier vidéo (100 signets au maximum).
La position du signet peut être légèrement différente de la position réelle.

Accéder à lire/Supprimer un signet
1. Appuyez sur l’icône  [ ] située sur 

l’écran de lecture de la vidéo.
Le menu <Video> (Vidéo) s’affi che.

2. Appuyez sur <Bookmark> (Signet).
Le menu <Bookmark> (Signet) s’affi che.

3. Appuyez sur <Go to> (Aller à) ou 
<Delete> (Supprimer).

Une fois l’option <Go to> (Aller à) sélectionnée, 
vous accédez au signet sélectionné et la lecture démarre à partir de ce signet.
L’option <Delete> (Supprimer) permet de supprimer le signet sélectionné du 
fi chier vidéo.

Appuyez sur l’icône [ ] pour quitter le menu.

REMARQUE

REMARQUE
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UTILISATION DU MENU VIDEO (Suite)
Régler la fonction Digital Natural Sound engine (DNSe)
Permet de choisir le type de son convenant le 
mieux à chaque genre de vidéo.
1. Appuyez sur l’icône [ ] pour affi cher la scène 

souhaitée durant la lecture de la vidéo.
Le menu <Video> (Vidéo) s’affi che.

2. Appuyez sur <DNSe>.
Le menu <DNSe> s’affi che.

3. Appuyez sur le DNSe souhaité.
Choisissez entre <Normal>, <Drama> (Drame) et <Action>.

Qu’est-ce que la fonctionnalité DNSe ?
La technologie Digital Natural Sound Engine (DNSe) est une fonction d’optimisation du son 
conçue par Samsung pour les lecteurs MP3. Cette option offre différents réglages sonores 
visant à améliorer le type de musique que vous écoutez.

Régler le trait horizontal
Vous pouvez avancer rapidement dans un fi chier à intervalles variés lorsque vous 
appuyez à droite ou à gauche de l’écran. Sautez l’ensemble d’un fi chier ou sautez 
plusieurs secondes à la fois.
1. Appuyez sur l’icône [ ] pour affi cher la scène 

souhaitée durant la lecture de la vidéo.
2. Appuyez sur <Horizontal Stroke> (Trait 

horizontal).
Le menu <Horizontal Stroke> <Trait horizontal> s’affi che. 

3. Appuyez sur le trait horizontal souhaité.
Choisissez entre <1 File> (1 fi chier), <Seek> 
(Rechercher), <10sec Skip> (Saut de 10 s), <30sec 
Skip> (Saut de 30 s) et <1min Skip> (Saut de 1 min).
Vers la gauche : permet d’avancer en fonction du réglage de l’intervalle du trait horizontal.
Vers la droite : permet de reculer en fonction du réglage de l’intervalle du trait horizontal.
<1 File> (1 fi chier) : si vous réglez <Horizontal Stroke> (Trait horizontal) sur <1 File> (1 fi chier), 
le fi chier précédent ou suivant est sélectionné.
Si l’option <Seek> (Rechercher) est réglée, faire glisser votre doigt vers la gauche/droite permet 
d’alterner entre les vitesses de lecture <x2>  <x4>  <x8>.

L’intervalle du trait horizontal peut être différent de l’intervalle de saut réel en fonction du 
fi chier.
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UTILISATION DU MENU VIDEO (Suite)
Sélectionner la taille de l’écran
Vous pouvez sélectionner la taille de l’affi chage lors de la lecture de la 
vidéo.
1. Appuyez sur l’icône [ ] située sur 

l’écran de lecture de la vidéo.
Le menu <Video> (Vidéo) s’affi che.

2. Appuyez sur <Screen Size> (Taille 
écran).

Le menu <Screen Size> <Taille écran> 
s’affi che. 

3. Appuyez sur la taille d’écran souhaitée.
Choisissez entre <Actual> (Réelle), <Standard>, <Full> (Plein écran) et 
<Zoom>.

Menu de taille d’écran

  <Standard>          <Full> (Plein écran)            <Zoom> 

Pour certains fi chiers vidéo, il est impossible d’affi cher le menu <Screen 
Size> (Taille écran) ou les menus associés.
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UTILISATION DU MENU VIDEO (Suite)
Avant de démarrer - Utilisez uniquement les écouteurs stéréo certifi és 
Bluetooth. Assurez-vous que vos écouteurs stéréo Bluetooth ont bien été 
enregistrés. <Connect to Headset> (Relier les écouteurs) s’affi che lorsque les 
écouteurs sont enregistrés. Pour de plus amples informations, reportez-vous 
à <Utilisation des écouteurs stéréo Bluetooth>. Reportez-vous à la page 88.

Relier des écouteurs stéréo Bluetooth
Vous pouvez relier directement des écouteurs Bluetooth enregistrés 
pendant la lecture de la vidéo.
1. Appuyez sur l’icône [ ] située sur 

l’écran de lecture de la vidéo.
Le menu <Video> (Vidéo) s’affi che.

2. Appuyez sur <Connect to Headset>
(Relier les écouteurs).

Si <Bluetooth Mode> (Mode Bluetooth) 
est réglé sur <Off> (Arrêt), il passe à <On> 
(Marche).
Une fois la connexion établie, l’icône [ ]
s’affi che à l’écran.
Vous pouvez écouter le son du fi chier vidéo via les écouteurs Bluetooth.

Déconnecter les écouteurs stéréo Bluetooth
1. Appuyez sur l’icône [ ] située sur 

l’écran de lecture de la vidéo.
Le menu <Video> (Vidéo) s’affi che.

2. Appuyez sur <Disconnect Headset>
(Débrancher écouteurs).

Les écouteurs Bluetooth sont déconnectés.
<DNSe> ne s’affi che pas lorsque les écouteurs 
stéréo Bluetooth sont reliés au lecteur.
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REMARQUE
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Songs 1/52

Audio Track 1

lecture de fi chiers musicaux
Avant de démarrer -  Branchez les écouteurs, puis allumez le lecteur et vérifi ez la 

batterie.
Appuyez sur l’icône [ ] pour revenir à l’écran précédent.
Appuyez longuement sur l’icône [ ] pour accéder à l’écran du menu principal.

LECTURE PAR CATEGORIE

1. Appuyez sur l’icône  située sur l’écran du menu principal
La liste <Music> (Musique) s’affi che.

2. Sélectionnez l’élément souhaité dans la liste musicale et appuyez dessus.
Le fi chier musical s’affi che.

3. Sélectionnez un fi chier musical à lire et appuyez dessus.
La lecture du fi chier musical démarre.

REMARQUE
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LECTURE PAR CATEGORIE (Suite)
Liste de fi chiers musicaux
Les informations sur le fi chier comprenant le nom de l’artiste, le nom de l’album, le titre de 
la plage et le genre s’affi chent en fonction des informations fi gurant sur l’étiquette ID3 du 
fi chier musical correspondant. Un fi chier sans étiquette ID3 s’affi che comme [Unknown] 
(inconnu).

Now Playing (En lecture) : Permet de lire le fi chier lu en dernier ou d’affi cher l'écran de 
lecture du fi chier en cours.
Artists (Artiste) : Lecture par artiste Albums : Lecture par album
Songs (Chansons)  : Lecture en ordre numérique ou alphabétique
Genres : Lecture par genre
Playlists (Listes de lecture) : Lecture par liste
Music Browser (Navig. musique) : Permet d’affi cher tous les fi chiers musicaux 
enregistrés dans le dossier musical.

Les fi chiers musicaux MP3 et WMA sont compatibles avec ce lecteur.
Les fi chiers MP1 ou MP2 possédant uniquement une extension modifi ée vers MP3 
peuvent ne pas être lus.
Qu’est-ce que l’étiquette ID3 ?
Il s’agit d’un élément attaché à un fi chier MP3 contenant les informations relatives 
au fi chier telles que le titre, l’artiste, l’album, l’année, le genre et un champ 
commentaire.

REMARQUE
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PAUSE
1. Appuyez sur l’icône [ ] ou sur le bouton  lorsque la lecture de la 

musique est en cours.
La lecture de la musique est interrompue.

2. Appuyez légèrement sur l’icône [ ] ou appuyez sur le bouton à
nouveau.

La lecture reprend à l’endroit où vous l’avez suspendue.

LECTURE DE LA PLAGE EN COURS A PARTIR DU DEBUT
1. Appuyez légèrement sur l’icône [ ] après 3 secondes de lecture.

La plage en cours est lue à partir du début.

LECTURE DE LA PLAGE PRECEDENTE
Marche à suivre 1
Appuyez sur l’icône [ ] dans les 3 premières 
secondes de lecture.
Appuyez deux fois sur l’icône [ ] après 3 
secondes de lecture.

Marche à suivre 2
Faites glisser votre doigt vers la droite.

La lecture de la plage précédente démarre.

Pendant la lecture de fi chiers VBR, la plage précédente 
peut ne pas être lue même si vous appuyez sur 
l’icône [ ] au cours des 3 premières secondes de lecture.

Songs 52/52

Audio Track 0

Marche à suivre 2
CAUTION



50 _ lecture de fi chiers musicaux

LECTURE DE LA PLAGE SUIVANTE
Marche à suivre 1
Appuyez sur l'icône [ ].

Marche à suivre 2
Faites glisser votre doigt vers la droite.

La lecture de la plage suivante démarre.

RECHERCHE A L’INTERIEUR D’UNE PLAGE
Marche à suivre 1
1. Appuyez longuement sur l’icône [ ] ou [ ]

pendant que la plage sélectionnée est en cours 
de lecture. 

Ces boutons permettent d’effectuer la recherche vers 
le début ou la fi n de la plage.

2. Relâchez l’icône dès que vous souhaitez 
reprendre la lecture.

La lecture commence dès que vous relâchez l’icône.

Marche à suivre 2
Appuyez légèrement sur le point souhaité de la barre 
de progression de la lecture.

Faire glisser votre doigt vers la gauche ou la droite permet d’avancer ou de 
reculer en fonction du réglage du trait horizontal. Reportez-vous à la page 62

Songs 1/52

Audio Track 1

Marche à suivre 2

Songs 2/52

Audio Track 2

REMARQUE
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CREATION D’UNE PLAYLIST
A L’AIDE DE SAMSUNG MEDIA STUDIO
Grâce à <Samsung Media Studio>, vous pouvez créer votre propre playlist.

Avant de démarrer -  Branchez le lecteur MP3 sur l’ordinateur.
Samsung Media Studio doit être installé sur l’ordinateur.

Création d’une playlist

1. Cliquez sur le bouton <Playlists> en haut de Samsung Media 
Studio.

La fenêtre Playlists apparaît.

2. Cliquez sur le bouton <Nouv. Playlist> au bas de l’écran.
La fenêtre Création apparaît.

3. Tapez le titre de la playlist et cliquez sur <OK>.
Lors de la création d’une nouvelle Playlist, celle-ci sera enregistrée dans la 
section <Playlists> de Samsung Media Studio.

2

1
[YP-P2 [MTP]]

OK 3

Portable [YP-P2[MTP]]
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CREATION D’UNE PLAYLIST SUR VOTRE LECTEUR 
MP3 (Suite)

Ajout de fi chiers musicaux à une playlist que vous 
avez créé

1. Cliquez sur le bouton <Bibliothèque> en haut de Samsung Media 
Studio.

La fenêtre Bibliothèque apparaît.
2. Cliquez sur le bouton <Playlists> dans le coin droit de la fenêtre.

La fenêtre Playlists apparaît.
3. Double-cliquez sur une playlist dans la fenêtre de droite.
4. Sélectionnez les fi chiers que vous souhaitez transférer dans la 

fenêtre <Bibliothèque>.
5. Cliquez sur l’icône .

Les fi chiers sélectionnés sont ajoutés à la playlist.

5

1

3
4

2
[YP-P2 [MTP]]



lecture de fi chiers musicaux _ 53

CREATION D’UNE PLAYLIST SUR VOTRE LECTEUR 
MP3 (Suite)

Transfert d’une playlist vers le lecteur avec Samsung 
Media Studio

1. Cliquez sur le bouton <Playlists> en haut de Samsung Media 
Studio.

La fenêtre Playlists apparaît.

2. Sélectionnez une playlist dans la fenêtre <Playlists>.
3. Cliquez sur l’icône .

La playlist sélectionnée sera transférée vers le dossier du lecteur en passant 
par le navigateur (<File Browser> (Dossier Navigateur>  <Playlists> (Listes de 
lecture)).

Le lecteur peut lire jusqu’à 400 listes de lecture et jusqu'à 400 fi chiers 
musicaux pour chaque liste de lecture.REMARQUE

1
[YP-P2 [MTP]]

32

Portable [YP-P2[MTP]]
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CREATION D’UNE LISTE DE LECTURE SUR VOTRE 
LECTEUR MP3
Si vous avez déjà téléchargé des fi chiers sur votre lecteur MP3, vous pouvez 
créer une liste de lecture « Favoris » sans Samsung Media Studio ou votre 
ordinateur.
1. Appuyez sur l’icône  située sur l’écran du menu 

principal
2. Sélectionnez <Music> (Musique) et appuyez dessus.

La liste des fi chiers musicaux s'affi che.

3 Sélectionnez un fi chier à ajouter à la liste de lecture et 
appuyez sur l’icône [ ].

Le menu de la liste de lecture apparaît.

4. Appuyez sur <Add to Playlist> (Aj. à liste lect.).
<Playlist 1> (List lect 1) à <Playlist 5> (List lect 5) apparaît.

5. Appuyez sur le numéro de la liste de lecture à laquelle 
vous souhaitez ajouter le fi chier sélectionné.

Le fi chier sélectionné est ajouté à la liste de lecture.
Vérifi ez la liste de lecture dans <Music> (Musique)  <Playlists> 
(Listes de lecture)  <Playlist 1> (List lect 1) à <Playlist 5> (List 
lect 5) dans le menu principal.

Vous pouvez ajouter jusqu’à 200 fi chiers musicaux dans 
chaque liste de lecture (<Playlist 1> (List lect 1) à 
<Playlist 5> (List lect 5)).

REMARQUE
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LECTURE D’UNE LISTE DE LECTURE
1. Appuyez sur l’icône  située sur l’écran du menu 

principal
La liste musicale s'affi che.

2. Sélectionnez <Playlists> (Listes de lecture) et appuyez 
dessus.

La/Les liste(s) de lecture s'affi che(nt).

3. Sélectionnez la liste de lecture souhaitée et appuyez 
dessus.

Les fi chiers musicaux enregistrés dans la liste de lecture 
sélectionnée apparaissent.
Si vous ne trouvez aucune liste de lecture, le message 
<No fi le.> (Aucun fi chier.) s’affi che à l’écran.

4. Sélectionnez un fi chier musical à lire et appuyez dessus.
La lecture du fi chier musical démarre.

Reportez-vous aux pages 51 et 53 pour en savoir plus sur 
le transfert de la liste de lecture avec <Samsung Media 
Studio>.

Playlists

Playlist 1
Playlist 2

Playlist 3

Playlist 4

Playlist 5

Song 1
Song 4

Song 6

Song 8

Song 9

Playlist 1 1/5

REMARQUE



56 _ lecture de fi chiers musicaux

SUPPRESSION D’UN FICHIER DE LA LISTE DE LECTURE
1. Appuyez légèrement sur l’icône  située sur l’écran du 

menu principal.
La liste musicale s’affi che.

2. Sélectionnez <Playlists> (Listes de lecture) et appuyez dessus.
La/Les liste(s) de lecture s'affi che(nt).

3. Sélectionnez la liste de lecture souhaitée et appuyez dessus.
Les fi chiers musicaux enregistrés dans la liste de lecture 
sélectionnée apparaissent.

4. Sélectionnez un fi chier à supprimer de la liste de lecture et 
appuyez sur l’icône  [ ].

Le menu de la liste de lecture apparaît.

5. Appuyez sur <Delete from Playlist> (Suppr. de liste lect.).
Une fenêtre de confi rmation s’affi che.

6. Appuyez sur <Yes> (Oui).
Le fi chier sélectionné est supprimé de la liste de lecture.

Le fi chier sélectionné dans la liste de lecture ne peut pas être supprimé en cours de lecture.

SUPPRESSION DE TOUS LES FICHIERS DE LA LISTE DE LECTURE
Suivez les étapes 1 à 3 ci-dessus.
4. Appuyez sur l'icône [ ].

Le menu de la liste de lecture apparaît.

5. Appuyez sur <Delete All from Playlist> (Suppr. de liste lect.).
Une fenêtre de confi rmation s’affi che.

6. Appuyez sur <Yes> (Oui).
Tous les fi chiers sont supprimés de la liste de lecture.

Song 1
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UTILISATION DU MENU MUSIQUE
Le menu Musique vous permet de gérer toutes les facettes de l’écoute (de la 
sélection des plages des playlists au choix du fond d’écran durant l'écoute).

Régler l’effet sonore
Profi tez d’une qualité de son plus nette.
1. Appuyez sur l’icône [ ] située sur l’écran de 

lecture musicale. 
Le menu <Music> (Musique) s’affi che.

2. Appuyez sur l'icône <Sound Effect>
(Effets Sonores).

Le menu <Sound Effect> (Effets Sonores) s’affi che.

3. Appuyez sur l’effet sonore souhaité.
Choisissez entre <Street Mode> (Mode Rue) et 
<Clarity> (Netteté).

Options d’effet sonore
Street Mode (Mode Rue) : Permet d’écouter clairement en extérieur grâce 
au fi ltrage de certains bruits de la rue. Sélectionnez <On> (Marche) ou <Off > 
(Arrêt).
Clarity (Netteté) : Vous bénéfi ciez d’un son plus clair et de meilleure qualité. 
Sélectionnez de <0-2>.

Appuyez sur l’icône [ ] pour quitter le menu.

Sound Effect

DNSe

Play Mode

Music Play Screen

Add to Alarm
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Songs 2/52

Audio Track 1
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UTILISATION DU MENU MUSIQUE (Suite)
Régler la fonction Digital Natural Sound engine (DNSe)
Vous permet de choisir le type de son convenant le mieux à chaque 
genre musical.
1. Appuyez sur l’icône [ ] située sur l’écran de 

lecture musicale.
Le menu <Music> (Musique) s’affi che.

2. Appuyez sur <DNSe>.
Le menu <DNSe> s’affi che.

3. Appuyez sur l’une des options DNSe.
Choisissez entre <Normal>, <Studio>, <Rock>, 
<Classical> (Classique), <Jazz>, <Ballad> (Ballade), 
<Club>, <Rhythm & Blues> (R&B), <Dance> 
(Danse), <Concert Hall> (Salle Concert) et <User> 
(Utilisateur).
Vous pouvez régler <EQ> (EG) et <3D&Bass> lorsque <User> (Utilisateur) 
est sélectionné. Reportez-vous à la page 59.

Vous pouvez également régler l’option DNSe en appuyant sur l'icône
[DNSe] située sur l'écran de lecture musicale.
Qu’est-ce que la fonctionnalité DNSe ?
La technologie Digital Natural Sound Engine (DNSe) est une fonction 
d’optimisation sonore conçue par Samsung pour les lecteurs MP3. Cette 
option offre différents réglages sonores visant à améliorer le type de 
musique que vous écoutez.

REMARQUE
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UTILISATION DU MENU MUSIQUE (Suite)
Régler la fonction Digital Natural Sound engine (DNSe) 
(Suite)
<3D&Bass>
permet de régler l'effet sonore 3D et le renforcement des 
basses.
1. Appuyez sur l'icône [  ] de l’option <User> (Utilisateur).

L’écran <User> (Utilisateur) apparaît.

2. Appuyez sur <3D&Bass>.
L’écran de réglage <3D&Bass> apparaît.

3. Sélectionnez <3D> ou <Bass> et appuyez sur l’icône
[ , ] pour régler le point souhaité. 

Vous pouvez sélectionner <0-4> pour les fonctions <3D> et 
<Bass>.

4. Appuyez sur <OK>.
Le réglage est terminé.

<EQ> <EG>
Cette fonction vous permet de paramétrer les fréquences 
individuellement afi n de régler le son selon vos préférences.
1 Appuyez sur l'icône [  ] de l’option <User>

(Utilisateur).
L’écran <User> (Utilisateur) apparaît.

2. Appuyez sur <EQ> (EG).
L’écran de réglage <EQ> (EG) apparaît.

3. Appuyez sur l’icône [  ,  ] pour sélectionner la 
fréquence que vous souhaitez régler, puis sur l’icône
[ , ] pour régler le niveau de la fréquence 
sélectionnée.

Les fréquences paramétrables sont <60Hz>, <150Hz>, 
<400Hz>, <1.1KHz> (1,1 KHz), <3.5KHz> (3,5 KHz), <8KHz> 
et <14KHz>.
Vous pouvez régler le niveau de la fréquence sélectionnée de <–10 ~ +10> (–10 à +10).

4. Appuyez sur <OK>.
Le réglage est terminé.
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OK Cancel
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OK Cancel
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UTILISATION DU MENU MUSIQUE (Suite)
Régler le mode de lecture
Permet de sélectionner le mode de lecture tel que les paramètres de 
répétition.
1. Appuyez sur l’icône [ ] située sur l’écran de 

lecture musicale.
Le menu <Music> (Musique) s’affi che.

2. Appuyez sur <Play Mode> (Mode lecture).
Le menu <Play Mode> (Mode lecture) s’affi che.

3. Appuyez sur le mode de lecture souhaité.
Choisissez entre <Normal>, <Repeat> (Répéter), 
<Repeat One> (Répéter 1X) et <Shuffl e> (Aléatoire).

Options du mode de lecture
Normal : Permet de lire toutes les plages dans l'ordre une seule fois.
Repeat (Répéter) : Permet de répéter la lecture de tous les fi chiers.
Repeat One (Répéter 1X) : Permet de répéter un fi chier.
Shuffl e (Aléatoire) : Permet de lire les fi chiers dans un ordre aléatoire.
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UTILISATION DU MENU MUSIQUE (Suite)
Sélectionner l’écran de lecture musicale
Sélectionnez une image de fond d’écran parmi celles fournies ou 
sélectionnez l’une de vos propres images à affi cher lorsque vous 
écoutez de la musique.
1. Appuyez sur l’icône [ ] située sur l’écran de 

lecture musicale.
Le menu <Music> (Musique) s’affi che.

2. Appuyez sur <Music Play Screen> (Ecran Lect mus.).
Le menu <Music Play Screen> (Ecran Lect mus.) 
s’affi che.

3. Appuyez sur l’icône [  ,  ] pour sélectionner 
l’écran de lecture musicale souhaité, puis sur 
<OK>.

Choisissez entre <Type 1>, <Type 2>, <Type 3>, 
<Type 4>, <Album Info.> (Info. Album) et <Album Art> 
(Image CD).

Options de l’écran de lecture musicale
Type 1 ~ Type 4 (Type 1 à Type 4) : Permet de sélectionner l’écran de lecture 
musicale souhaité.
Album Info. (Info.album) : Les informations concernant le nom de l’artiste, 
l’album et le genre s’affi chent si celles de l’étiquette ID3 sont enregistrées dans 
le fi chier musical.
Album Art (Image CD) : L’image de la jaquette du CD s'affi che si une image de 
jaquette fi gure dans les informations de l’étiquette ID3 du fi chier musical. Les 
images de la jaquette du CD d’une taille inférieure à 200 pixels (horizontal) x 
200 pixels (vertical) sont prises en charge.

Qu’est-ce que l’étiquette ID3 ?
Il s’agit d’un élément attaché à un fi chier MP3 contenant les informations 
relatives au fi chier telles que le titre, l’artiste, l’album, l’année, le genre et 
un champ commentaire.

REMARQUE

Sound Effect

DNSe

Play Mode

Music Play Screen

Add to Alarm

Horizontal Stroke

Songs 2/52

Audio Track 1

Type 4

OK Cancel



62 _ lecture de fi chiers musicaux

UTILISATION DU MENU MUSIQUE (Suite)
Ajouter à la sonnerie de l’alarme
Vous pouvez ajouter votre fi chier musical favori à la liste des sonneries 
d’alarme afi n de l’écouter lorsque l’alarme se déclenche. 
Reportez-vous à la page 82 pour régler l’alarme.
1. Sélectionnez un fi chier musical à ajouter à la liste 

des sonneries et appuyez sur l’icône [ ].
Le menu <Music> (Musique) s’affi che.

2. Appuyez sur <Add to Alarm> (Ajouter à alarme).
Une fenêtre d’enregistrement s’affi che.

3. Appuyez sur <OK>.
La musique sélectionnée est ajoutée à la liste des 
sonneries d’alarme.
Un seul fi chier musical peut être ajouté à la sonnerie d’alarme.

Régler le trait horizontal
Vous pouvez régler l’intervalle du trait afi n de parcourir le fi chier musical pendant 
la lecture en faisant glisser votre doigt vers la gauche ou vers la droite.
1. Appuyez sur l’icône [ ] située sur l’écran de 

lecture musicale.
Le menu <Music> (Musique) s’affi che.

2. Appuyez sur <Horizontal Stroke> (Trait horizontal).
Le menu <Horizontal Stroke> (Trait horizontal) s’affi che.

3. Appuyez sur le trait horizontal souhaité.
Choisissez entre <1 File> (1 fi chier), <10sec Skip> 
(Saut de 10 s), <30sec Skip> (Saut de 30 s) et 
<1min Skip> (Saut de 1 min).

Si le fi chier a été ouvert avec un débit binaire variable, 
il se peut que la longueur réelle du trait horizontal soit 
légèrement différente de celle que vous avez sélectionnée.

REMARQUE
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UTILISATION DU MENU MUSIQUE (Suite)
Avant de démarrer - Utilisez uniquement les écouteurs stéréo certifi és Bluetooth. 
Assurez-vous que vos écouteurs stéréo Bluetooth ont bien été enregistrés. <Connect 
to Headset> (Relier les écouteurs) s’affi che lorsque les écouteurs sont enregistrés. 
Pour de plus amples informations, reportez-vous à <Utilisation des écouteurs stéréo 
Bluetooth>. Reportez-vous à la page 88.

Relier des écouteurs stéréo Bluetooth
Vous pouvez relier directement les écouteurs stéréo 
Bluetooth enregistrés pendant la lecture musicale.
1. Appuyez sur l’icône [ ] située sur l’écran de 

lecture musicale.
Le menu <Music> (Musique) s’affi che.

2. Appuyez sur <Connect to Headset> (Relier les 
écouteurs).

Si <Bluetooth Mode> (Mode Bluetooth) est réglé sur 
<Off> (Arrêt), il passe à <On> (Marche).
Une fois la connexion établie, l’icône [ ] s’affi che. 
Vous pouvez écouter de la musique via les écouteurs 
Bluetooth.

Déconnecter les écouteurs stéréo Bluetooth
1. Appuyez sur l’icône [ ] située sur l’écran de 

lecture musicale.
Le menu <Music> (Musique) s’affi che.

2. Appuyez sur <Disconnect Headset> (Débrancher 
écouteurs).

Les écouteurs Bluetooth sont déconnectés.

<Sound Effect> (Effets sonores) et <DNSe> ne 
s’affi chent pas lorsque le lecteur est connecté aux 
écouteurs stéréo Bluetooth.

Sound Effect

DNSe

Play Mode

Music Play Screen

Add to Alarm

Horizontal Stroke

Connect to Headset

Songs 2/52

REMARQUE

Play Mode

Music Play Screen

Add to Alarm

Horizontal Stroke

Disconnect Headset

Songs 2/52
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affi chage des images
Avant de démarrer - Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.
Appuyez sur l’icône [ ] pour revenir à l’écran précédent.
Appuyez longuement sur l’icône [ ] pour accéder à l’écran du menu principal.

1. Appuyez légèrement sur l’icône située sur l’écran du 
menu principal.

La fenêtre de prévisualisation apparaît.

2. Sélectionnez l’image à affi cher et appuyez dessus.
L’image sélectionnée s'affi che.
Appuyez sur l’icône [ ] pour revenir à la fenêtre de prévisualisation.

Accéder à l’image précédente/suivante
Appuyez sur l’icône [  ,  ] située sur l’écran 
d’affi chage de l’image.

L’image précédente/suivante s'affi che.
Les informations et les icônes de l’image actuellement affi chée disparaissent rapidement. Appuyez 
légèrement sur l’écran pour affi cher à nouveau les informations relatives à l’image et les icônes.
L’icône [  , ] de l’image précédente/suivante apparaît si vous appuyez une fois sur l’écran. 
Appuyer à nouveau dessus permet d’affi cher les informations concernant l’image et les icônes.
Les fi chiers JPG ne comportant pas de vignettes ou comportant des informations erronées 
sur les vignettes affi chent [  ].
Certaines images peuvent être affi chées lentement.
Avant le transfert du fi chier image vers le lecteur à l'aide du logiciel <Samsung Media 
Studio>, celui-ci est tout d’abord converti automatiquement au format JPG. La taille du 
fi chier est également réglée automatiquement.
Vous pouvez également utiliser la fonction <File Browser> (Dossier Navigateur) pour 
rechercher une image. Reportez-vous à la page 23.
Vous pouvez continuer à écouter le fi chier musical en cours même lorsque vous 
sélectionnez <Pictures> (Images) pour affi cher une image.

REMARQUE

REMARQUE
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UTILISATION DU MENU IMAGE
Visionner un diaporama
Marche à suivre 1
Appuyez sur l’icône [ ] située sur l’écran de 
prévisualisation.

L’icône [ ] apparaît à l’écran et le diaporama démarre.

Marche à suivre 2
1. Appuyez sur l’icône [ ] située sur l’écran 

d’affi chage de l’image.
Le menu <Pictures> (Images) s’affi che.

2. Appuyez sur <Start Slideshow>
(Démarrer diaporama).

L’icône [ ] apparaît à l’écran et le diaporama 
démarre.

Régler la vitesse du diaporama
1. Appuyez sur l’icône [ ] située sur l’écran 

d’affi chage de l’image.
Le menu <Pictures> (Images) s’affi che.

2. Appuyez sur <Slideshow Speed> (Vitesse 
diaporama).

Le menu <Slideshow Speed> (Vitesse diaporama) 
s’affi che.

3. Appuyez sur la vitesse souhaitée.
Choisissez entre <Fast> (Rapide), <Normal> et 
<Slow> (Lent).

Appuyez sur l’icône [ ] pour quitter le menu.
REMARQUE

Start Slideshow

Slideshow Speed

Select as My Skin

View Mode

Fast

Normal

Slow
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UTILISATION DU MENU IMAGE (Suite)
Arrêt du diaporama
Appuyez sur l’écran en mode diaporama.

Le diaporama s'arrête.

Sélectionner une image comme fond d’écran
Vous pouvez défi nir l’image de votre choix comme fond d’écran.
1. Sélectionnez une image à défi nir en fond d’écran 

et appuyez sur l’icône [ ].
Le menu <Pictures> (Images) s’affi che.

2. Appuyez sur <Select as My Skin> (Sélectionner 
comme habillage).

Une fenêtre d’enregistrement s’affi che.

3. Appuyez sur <Yes> (Oui).
L’image sélectionnée est réglée comme image de fond 
d’écran.

Start Slideshow

Slideshow Speed

Select as My Skin

View Mode
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UTILISATION DU MENU IMAGE (Suite)
Sélectionner le mode d’affi chage de l'image
1. Appuyez sur l’icône [ ] située sur l’écran 

d’affi chage de l’image.
Le menu <Pictures> (Images) s’affi che.

2. Appuyez sur <View Mode> (Mode Affi chage).
Le menu <View Mode> (Mode Affi chage) s’affi che.

3. Appuyez sur le mode souhaité.
Choisissez entre <Auto> et <Horizontal>.
Si vous sélectionnez <Horizontal>, l’image s’affi che 
horizontalement.

Agrandir une image
Vous pouvez zoomer sur une image.
1. Appuyez sur l’icône [ ] située sur l’écran 

d’affi chage de l’image.
L’image est agrandie.
Chaque fois que vous appuyez sur l’icône [ ], la taille 
de l’image est agrandie de <x2>  <x3>  <x4>.
Pour annuler l’agrandissement de l’image, appuyez 
sur l’icône [ ].

2. Faites glisser votre doigt dans la direction souhaitée 
pour la déplacer. Reportez-vous à la page 18.

Vous pouvez déplacer l'image agrandie dans la 
direction souhaitée.

L’agrandissement d’un fi chier image volumineux peut 
prendre un certain temps.

Start Slideshow

Slideshow Speed

Select as M

View Mode

Auto

Horizontal

X2X2

REMARQUE
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ecouter la radio FM
Avant de démarrer -  Branchez les écouteurs, puis allumez le lecteur et vérifi ez le 

bloc-piles.
Appuyez sur l’icône [ ] pour revenir à l’écran précédent.
Appuyez longuement sur l’icône [ ] pour accéder à l’écran du menu principal.

 Appuyez légèrement sur l’icône  située sur l’écran du 
menu principal.

La réception de la radio FM est activée.

POUR UTILISER LA FONCTION MUTE (SILENCE)
Appuyez sur le bouton  lorsque vous écoutez la 
radio FM.

Le son est désactivé.
Appuyez à nouveau sur le bouton  pour reprendre 
l’écoute.

Branchez toujours vos écouteurs sur le lecteur lorsque vous 
recherchez ou réglez des fréquences. Les écouteurs sont 
utilisés comme antennes de réception des ondes FM.
Dans les zones où la qualité de réception est mauvaise, il se 
peut que le lecteur ne détecte aucune fréquence FM. 
La fonction Bluetooth ne peut pas être utilisée lorsque vous 
écoutez la radio FM.

REMARQUE

REMARQUE

FM Radio
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POUR RECHERCHER DES STATIONS DE RADIO FM
1. Appuyez longuement sur l’icône [ , ] et relâchez en 

mode Manuel.
<Searching> (Recherche en cours) apparaît à l’écran.
La recherche s’arrête sur la fréquence la plus proche du point de 
relâchement du bouton.

OU,

1. Appuyez sur l’icône [ , ] pour rechercher les fréquences 
une par une en mode Manuel.

Change de fréquence à chaque nouvelle pression sur l’icône.

FM Radio

FM Radio

 Searching 
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UTILISATION DU MENU DE LA RADIO FM
Pour basculer vers le mode manuel
Sélectionnez ce mode si vous souhaitez effectuer une recherche 
manuelle d’une fréquence à la fois sur la bande FM.
1. Appuyez sur l'icône [ ] en mode Manuel.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez sur <Go to Preset Mode> (Aller au 
mode pré-programmation).

La réception de la radio FM est activée.
<PRESET> s’affi che.

Si aucune fréquence n’est présélectionnée, <Preset 
list does not exist> (Liste présél. n'existe pas) 
s’affi che et le lecteur ne passe pas en mode de 
préréglage.
Si <Default Set> (Réglage par défaut) est sélectionné 
dans <Settings> (Paramètres)  <System> 
(Système), les listes présélectionnées enregistrées 
sont supprimées.
Les fréquences préréglées sont enregistrées par ordre numérique.

Pour basculer vers le Mode présélection
Sélectionnez ce mode si vous souhaitez effectuer 
une recherche de vos
présélections FM une à la fois.
1. Appuyez sur l'icône [ ] en mode de préréglage.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez sur <Go to Manual Mode> (Aller au 
mode manuel).

<MANUAL> s’affi che.

REMARQUE

FM Radio

FM Radio
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UTILISATION DU MENU DE LA RADIO FM (Suite)
Pour enregistrer des stations dans la mémoire de présélection
Vous pouvez enregistrer jusqu’à 30 stations dans la mémoire de votre 
lecteur MP3 et y accéder en appuyant simplement sur un chiffre. Le lecteur 
MP3 peut soit choisir uniquement les stations souhaitées (manuellement) 
ou rechercher et enregistrer automatiquement les stations locales.
Manuel : sélectionnez uniquement les stations que vous souhaitez 
enregistrer
1. Appuyez sur l’icône [ , ] pour sélectionner 

une fréquence à prérégler en mode manuel et 
appuyez sur l’icône [ ].

2. Appuyez sur <Add to Preset> (Ajouter aux présél.).
Un numéro de préréglage est attribué à la station sélectionnée.

Si la même fréquence est déjà réglée, le message 
<This preset already exists> (Cette présél. existe 
déjà.) s’affi che et le réglage est désactivé.

Pour écouter une station présélectionnée
Appuyez sur le numéro préréglé souhaité en mode 
de préréglage.

Le numéro préréglé est sélectionné et vous pouvez 
alors écouter la fréquence radio associée à ce 
numéro.
Appuyez sur l’icône [ , ] pour revenir à la liste de 
numéros précédente ou suivante.

Appuyez sur l’icône [ ] pour quitter le menu.

REMARQUE

FM Radio

Go to Preset Mode

Add to Preset

Auto Preset

FM Sensitivity

FM Region

FM Radio

REMARQUE
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UTILISATION DU MENU DE LA RADIO FM (Suite)
Pour enregistrer des stations dans la mémoire de 
présélection (Suite)
Automatique : enregistrez automatiquement toutes les stations 
captées par le lecteur
1. Appuyez sur l’icône [ ] située sur l’écran de la 

radio FM.
Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez sur <Auto Preset> (Présélection auto).
La fenêtre <Auto Preset> (Présélection auto) s’affi che.

3. Appuyez sur <OK>.
Le message <Auto Preset> (Présélection auto) 
s’affi che et jusqu’à 30 fréquences radio sont 
automatiquement réglées.

Pour annuler la présélection automatique
Si vous souhaitez annuler la présélection automatique, appuyez sur 
n’importe quel bouton au cours du processus. 

La présélection automatique est annulée et seules les fréquences réglées 
jusque-là sont enregistrées.

Si vous vous rendez dans une autre région avec votre lecteur MP3, vous 
souhaiterez peut-être régler à nouveau les stations enregistrées. Pour 
supprimer les stations préréglées et en enregistrer de nouvelles, il suffi t de 
répéter le processus.

REMARQUE

FM Radio

Go to Preset Mode

Add to Preset

Auto Preset

FM Sensitivity

FM Region
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UTILISATION DU MENU DE LA RADIO FM (Suite)
Pour supprimer une présélection
Suivez les étapes suivantes pour supprimer les fréquences tout en 
écoutant la radio FM.
1. Appuyez sur l'icône [ ] en mode de préréglage.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez sur <Delete from Preset> (Suppr. du 
prérégl.).

La liste des fréquences préréglées s’affi che.

3. Sélectionnez la fréquence à affi cher et appuyez 
dessus.

Une fenêtre de confi rmation apparaît.

4. Appuyez sur <Yes> (Oui).
Le numéro présélectionné est supprimé.
Si vous ne souhaitez pas supprimer le numéro présélectionné, sélectionnez 
<No> (Non).

Lorsqu’une fréquence préréglée est supprimée, le numéro des préréglages 
suivants se déplace d’un degré vers le haut.REMARQUE

FM Radio

Go to Manual Mode

Delete from Preset

Auto Preset

FM Sensitivity

FM Region



74 _ ecouter la radio FM

UTILISATION DU MENU DE LA RADIO FM (Suite)
Pour régler la Sensibilité FM
Pour recevoir plus ou moins de fréquences radio FM, paramétrez 
la fonction <FM Sensitivity> (Sensibilité FM).
1. Appuyez sur l’icône [ ] située sur l’écran de la radio FM.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez sur <FM Sensitivity> (Sensibilité FM).
Le menu <FM Sensitivity> (Sensibilité FM) s’affi che.

3. Appuyez sur l’emplacement de la réception.
Choisissez entre <High> (Haut), <Middle> (Milieu) et <Low> 
(Bas).
Le réglage <High> (Haut) vous permet de recevoir le plus grand 
nombre de fréquences.

Réglage de la région FM
Vous avez la possibilité de modifi er le réglage FM en 
prévision d’un voyage à l’étranger.
1. Appuyez sur l’icône [ ] située sur l’écran de la radio FM.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez sur <FM Region> (Région Radio).
Le menu <FM Region> (Région Radio) s’affi che.

3. Appuyez sur la zone FM souhaitée.
Choisissez entre <Korea/US> (Corée/USA), <Japan> (Japon) 
ou <Other Countries> (Autres pays).

Bande de fréquences par région
   - Korea/US (Corée/USA) : recherchez des fréquences FM 

comprises entre 87,5 MHz et 108,0 MHz pour les lecteurs de 
100 kHz.

   - Japan (Japon) : recherchez des fréquences FM comprises entre 
76,0 MHz et 108 MHz pour les lecteurs de 100 kHz.

   - Other Countries (Autres pays) : recherchez des fréquences FM comprises entre 87,50 MHz et 
108,00 MHz pour les lecteurs de 50 kHz.

La région FM peut être supprimée ou modifi ée en fonction de la région cible du lecteur.
Les fréquences radio que vous avez enregistrées précédemment seront supprimées si vous 
modifi ez le réglage <FM Region> (Région FM) de votre lecteur.

REMARQUE

FM Radio

Go to Preset Mode

Add to Preset

Auto Preset

FM Sensitivity
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Korea/US

Japan
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utilisation de la diffusion de données
Avec <Samsung Media Studio>, vous pouvez transférer vers le lecteur les 
informations relatives au format RSS.

Qu'est-ce que le format RSS ?
RSS correspond à Rich Site Summary ou Really Simple Syndication. Il s’agit d’un système 
de transfert de données XML utilisé pour fournir aux utilisateurs, de manière plus pratique et 
plus facile, des informations sur les sites Internet fréquemment mis à jour (Actualités, Blogs).
Qu’est-ce que la diffusion de données ?
Vous pouvez recevoir automatiquement les informations mises à jour sans avoir à 
vous rendre sur les sites d’actualités, les blogs ou les UCC.
Avant de démarrer – Samsung Media Studio doit être installé sur l'ordinateur. 

Reportez-vous à la page 36.

ENREGISTREMENT D’UNE CHAINE
Vous pouvez créer une nouvelle chaîne en enregistrant les sites Internet ou les pages 
Web pris(es) en charge par le système RSS.
1. Cliquez sur le bouton <Subscribe>

(S’abonner) situé au bas de l’écran 
<Datacasts> (Dif. donn.) de <Samsung 
Media Studio>.

2. Saisissez une adresse dans <URL> et 
cliquez sur < Next> ( Suivant).

Lorsque vous copiez une adresse Internet et 
que vous cliquez sur <Subscribe> (S’abonner), 
l’adresse copiée s’affi che automatiquement 
dans l’<URL>.
La fenêtre de confi rmation du réglage s’affi che si l’adresse Internet prend en charge le 
format RSS.

3. Cliquez sur <OK>.
La chaîne souhaitée est enregistrée.
L’icône  s’affi che dans Datacasts (Dif. donn.) pour le canal enregistré.

2

2

REMARQUE
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CREATION D’UN NOUVEAU GROUPE DE CHAINES
Vous pouvez créer un nouveau groupe afi n de gérer les chaînes par catégorie.
1. Cliquez sur le bouton <New Group> (Nouveau groupe) 

situé au bas de l’écran <Datacasts> (Dif. donn.) de 
<Samsung Media Studio>.

2. Saisissez un nom de groupe et une description et cliquez 
sur <OK>.

TRANSFERT DES DONNEES DEPUIS <SAMSUNG 
MEDIA STUDIO>

Avant de démarrer – Branchez le lecteur sur l'ordinateur. Samsung Media Studio doit être 
installé sur l'ordinateur. Reportez-vous à la page 36.

1. <Samsung Media Studio> démarre 
automatiquement lorsque vous branchez le lecteur 
sur votre ordinateur.

Si le programme ne démarre pas automatiquement, 
double-cliquez sur l'icône  <Samsung Media Studio> 
située sur le Bureau.

2. Cliquez sur <Datacasts> (Dif. donn.) située 
dans la partie supérieure de <Samsung Media 
Studio>.

La liste de chaînes du groupe de diffusion de données 
s’affi che.

3. Cliquez sur la chaîne du groupe souhaité.
4. Cliquez sur la chaîne souhaitée.
5. Sélectionnez l’élément que vous souhaitez 

transférer.
6. Cliquez sur l'icône .

L’élément de la chaîne sélectionnée est transféré vers le lecteur dans <File Browser> (Dossier 
Navigateur)  <Datacasts> (Dif. donn.).

Cliquez sur  dans la partie supérieure de <Samsung Media Studio> pour accéder à l’écran 
précédent.
Dans <Datacasts> (Dif. donn.) de <Media Studio> (Media Studio), si l’élément comporte une 
pièce jointe, vous pouvez télécharger ce dernier sur le lecteur. Cependant, il est possible que le 
fi chier joint ne puisse pas être téléchargé en fonction de la politique de sécurité du site Internet.

REMARQUE

2

6
5

2 Portable [YP-P2[MTP]]

[YP-P2[MTP]]
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AFFICHAGE DES DIFFUSIONS DE DONNEES
Vous pouvez affi cher les éléments de chaîne ajoutés à <Datacasts> (Dif. donn.).

Avant de démarrer –  Transférez l’élément de chaîne souhaité vers le lecteur avec 
<Samsung Media Studio>. Reportez-vous à la page 76.

Appuyez sur l’icône [ ] pour revenir à l’écran précédent.
Appuyez longuement sur l’icône [ ] pour accéder à l’écran du menu principal.

1. Appuyez légèrement sur l’icône située sur l’écran du 
menu principal.

La liste de diffusion s'affi che.

2. Sélectionnez le titre de la chaîne souhaitée et appuyez 
dessus.

Le titre est le même que celui de la chaîne ajoutée à 
<Datacasts> (Dif. donn.) dans <Samsung Media Studio>.

3. Sélectionnez le titre de l’élément souhaité et appuyez 
dessus.

La liste des fi chiers s'affi che.

Icône  : Texte principal de l’élément transféré
Icône  : Fichier image
Icône  : Fichier musical
Icône  : Fichier vidéo

4. Sélectionnez un fi chier et appuyez dessus.
La lecture du fi chier sélectionné démarre.

REMARQUE

Data Cast 1/3

Datacast 1
Datacast 2

Datacast 3
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utilisation du pack plus
Le pack plus vous permet d’utiliser différentes fonctions telles que la lecture de 
texte, le réglage de l’alarme et l’affi chage du calendrier ou de l’horloge universelle.

LECTURE DE TEXTE
Qu’il s’agisse d’un roman, d’un scénario ou d’un article, votre lecteur 
MP3 vous permet de le lire tout en écoutant de la musique !

Avant de démarrer - Allumez le lecteur et vérifi ez la batterie.
Transférez les fi chiers texte vers le lecteur à l’aide de 
<Samsung Media Studio>. Reportez-vous à la page 37.
Réglez la langue du texte dans <Settings> (Paramètres)

<Language> (Langue) <Contents> (Sommaire).
Reportez-vous à la page 29.
Appuyez sur l’icône [ ] pour revenir à l’écran précédent.
Appuyez longuement sur l’icône [ ] pour accéder à l’écran 
du menu principal.

1. Appuyez légèrement sur l’icône située sur l’écran du 
menu principal.

La liste <Prime Pack> (Pack plus) s’affi che.
2. Sélectionnez <Texts> (Textes) et appuyez dessus.

La liste des fi chiers texte s'affi che.
3. Sélectionnez un fi chier texte et appuyez dessus.

Le texte s'affi che à l'écran.
Appuyez longuement sur l’écran tactile pour activer le mode Plein écran.
Pour revenir à l’écran précédent, appuyez à nouveau 
longuement sur l’écran tactile.

Vous pouvez également utiliser la fonction <File Browser> 
(Dossier Navigateur) pour rechercher un fi chier texte.
Votre lecteur MP3 prend en charge les fi chiers au format TXT 
en mode Texte.
Vous pouvez continuer à écouter de la musique même 
lorsque vous sélectionnez un fi chier texte.

REMARQUE

REMARQUE

Prime Pack

Texts
Alarm

Calendar

World Clock
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UTILISATION DU MENU TEXTE
Accéder à la page précédente/suivante

Marche à suivre 1
Appuyez sur l’icône [ , ] située au bas de l’écran 
tactile.

Marche à suivre 2
Faites glisser votre doigt vers la gauche ou vers la 
droite.

Faire glisser votre doigt vers la gauche permet 
d’affi cher la page suivante alors que le faire glisser 
vers la droite permet d’affi cher la page précédente.

Réglage d'un signet
Défi nissez un signet pour revenir à tout moment à ce point du texte.
1. Appuyez légèrement sur l’icône [ ] située sur la 

page souhaitée, sur l’écran d’affi chage de texte.
Le menu <Bookmark> (Signet) apparaît.

2. Appuyez sur <Add Bookmark> (Ajouter signet).
L'écran du texte actuel est associé à un signet et le 
symbole [ ] s'affi che dans le coin supérieur gauche. 

La fenêtre Réécrire apparaît si un signet a déjà été 
défi ni. Si vous sélectionnez <Yes> (Oui), le signet 
préalablement défi ni est supprimé et un nouveau 
signet est ajouté.
Un signet peut être défi ni pour chaque fi chier texte 
(100 signets au maximum).

Texts 1 7.0%

My doggy likes to disco dance.

He boogies every night.

He dances in his doghouse

till the early morning light.

The other dogs come running

when they hear my doggy swing.

A few will bring play their instruments 

The others dance and sing.

They pair off with their partners

as their tails begin to wag.

Add Bookmark

REMARQUE

Texts 1 7.0%

My doggy likes to disco dance.

He boogies every night.

He dances in his doghouse

till the early morning light.

The other dogs come running

when they hear my doggy swing.

A few will bring play their instruments 

The others dance and sing.

They pair off with their partners

as their tails begin to wag.
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Texts 1 7.0%

My doggy likes to disco dance.

He boogies every night.

He dances in his doghouse

till the early morning light.

The other dogs come running

when they hear my doggy swing.

A few will bring play their instruments 

The others dance and sing.

They pair off with their partners

as their tails begin to wag.Add Bookmark

Go to Bookmark

Delete Bookmark

UTILISATION DU MENU TEXTE (Suite)
Accès à/Suppression d’un signet
1. Appuyez sur l’icône [ ] située sur l’écran 

d’affi chage du texte.
Le menu <Bookmark> (Signet) apparaît.

2. Appuyez sur <Go to Bookmark> (Accéd. à 
signet) ou <Delete Bookmark> (Supprimer 
signet).

Vous accédez au signet sélectionné lorsque vous 
cliquez sur <Go to Bookmark> (Accéd. à Signet) et le 
supprimez du fi chier texte lorsque vous sélectionnez 
<Delete Bookmark> (Supprimer signet).

Réglage de la couleur de la visionneuse de texte
Choisissez la couleur d’affi chage du texte.
1. Appuyez sur l’icône [ ] située sur l’écran 

d’affi chage du texte.
Le menu <Text> (Texte) apparaît.

2. Appuyez sur <Text Viewer Color> (Coul. 
visionn. text).

La fenêtre du menu <Text Viewer Color> (Coul. 
visionn. text) apparaît.

3. Appuyez sur l’icône [  ,  ] pour sélectionner 
la couleur du visionneur de texte.

Options disponibles : <Type 1> à <Type 9>.

4. Appuyez sur <OK>.
La couleur du visionneur de texte sélectionnée s’affi che.

My doggy likes to disco dance.

He boogies every night.

He dances in his doghouse

till the early morning light.

The other dogs come running

when they hear my doggy swing.

Text Viewer Color

Type 1

OK Cancel
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UTILISATION DU MENU TEXTE (Suite)

Modifi er la taille de la police
Vous pouvez modifi er la taille de la police utilisée dans le texte.
1. Appuyez sur l’icône [ ] située sur l’écran 

d’affi chage du texte.
Le menu <Text> (Texte) apparaît.

2. Appuyez sur <Font Size> (Taille police).
Le menu <Font Size> (Taille police) s’affi che.

3. Appuyez sur l’icône [  ,  ] pour sélectionner 
la taille de police souhaitée.

Choisissez entre <Small> (Petit), <Medium> (Moyen) 
et <Large>.

4. Appuyez sur <OK>.
La taille de la police est modifi ée.

My doggy likes to disco dance.

He boogies every night.

He dances in his doghouse

till the early morning light.

The other dogs come running

when they hear my doggy swing.

Font Size

Small

OK Cancel
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REGLAGE DE L’ALARME
Ce lecteur dispose d’une alarme dont la désactivation peut être programmée à 
une heure défi nie.

Avant de démarrer - Vous devez tout d’abord régler l’horloge. Voir page 31.

1. Appuyez légèrement sur l’icône  située sur l’écran 
du menu principal.

Le menu <Prime Pack> (Pack plus) apparaît. 

2. Sélectionnez <Alarm> (Alarme) et appuyez dessus.
3. Appuyez sur <New Alarm> (Nouvelle alarme).

L’écran de réglage de l’alarme s’affi che.

4. Appuyez plusieurs fois sur le premier élément pour 
sélectionner la fréquence de l’alarme.

Choisissez entre <Once> (Une fois), <Everyday> (Ts les 
jours>, <Mon~Fri> (Lun~Ven), <Mon~Sat> (Lun~Sam), 
<Sat~Sun> (Sam~Dim) et <Off> (Arrêt).

5. Appuyez sur le second élément.
L’écran de réglage de l’heure de l’alarme s’affi che.

6. Appuyez sur l’icône [  ,  ]  afi n de régler l’heure, les 
minutes et la période AM/PM.

7. Appuyez sur <OK> sur l’écran de réglage de l’heure de 
l’alarme.

OK Cancel

Prime Pack

Texts

Alarm
Calendar

World Clock
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REGLAGE DE L’ALARME (Suite)

8. Appuyez plusieurs fois sur le troisième élément pour 
sélectionner la sonnerie de l’alarme.

Vous pouvez choisir entre <Alarm Sound 1> (Son alarme 1) 
à <Alarm Sound 3> (Son alarme 3) ou choisir des fi chiers 
musicaux ajoutés comme sonnerie d’alarme. Reportez-vous à 
la page 62.

9. Appuyez plusieurs fois sur le quatrième élément pour 
régler l’intervalle de l’alarme.

Une fois l’intervalle réglé, l’alarme se répète dans l’intervalle 
de temps défi ni. Choisissez entre <Interval: 3min> (Intervalle : 
3min), <Interval: 5min> (Intervalle : 5min) et <Interval: 10min> 
(Intervalle : 10min).

10. Appuyez sur <OK>.
La fenêtre de confi rmation d’enregistrement apparaît.

11. Appuyez sur <Yes> (Oui).
Le réglage de l’alarme est ajouté à la liste des alarmes.

Vous pouvez enregistrer jusqu'à 7 alarmes.
REMARQUE

Once

12 : 40 AM

Alarm Sound 1

Interval : 5min

Alarm
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Alarm

New Alarm

AM 01 : 53

REGLAGE DE L’ALARME (Suite)
Modifi er le réglage de l’alarme
1. Sur l’écran Alarme, sélectionnez un réglage 

d’alarme à modifi er et appuyez dessus.
L’écran de réglage de l’alarme s’affi che.

2. Suivez les mêmes étapes que le réglage de 
la nouvelle alarme ci-dessus pour modifi er le 
réglage. Reportez-vous à la page 82.

Supprimer un réglage d’alarme
1. Appuyez sur le réglage de l’alarme à supprimer 

sur l’écran d’alarme.
2. Appuyez sur l'icône [ ].

Appuyez sur l’icône [ ] pour supprimer tous le 
réglage.
La fenêtre de suppression apparaît.

3. Appuyez sur <Yes> (Oui).
L’alarme sélectionnée va être supprimée.

Le lecteur émet l’alarme lorsqu’il atteint l’heure programmée. L’alarme s’interrompt 
longuement et retentit à nouveau après l’intervalle d’alarme préalablement réglé si aucun 
bouton ou écran tactile n’est actionné. L’alarme retentit de manière répétée pendant une 
heure si aucune action n’est effectuée.
Si le câble USB est relié au lecteur, la fonction d’alarme ne peut pas être utilisée.

REMARQUE

CAUTION

Once

12 : 40 AM

Alarm Sound 1

Interval : 5min

Alarm
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AFFICHAGE DU CALENDRIER
Vous pouvez vérifi er le calendrier.

Avant de démarrer - Vous devez tout d’abord régler l’horloge. Voir page 31.

1. Appuyez légèrement sur l’icône  située sur l’écran 
du menu principal.

Le menu <Prime Pack> (Pack plus) apparaît. 

2. Sélectionnez <Calendar> (Calendrier) et appuyez 
dessus.

L’écran <Calendar> (Calendrier) apparaît.

3. Appuyez légèrement sur l’icône [ , ] pour sélectionner 
le mois souhaité.

Régler le type de calendrier
Vous pouvez affi cher le calendrier en modifi ant l’ordre des jours de la 
semaine.
1. Appuyez sur l’icône [ ] située sur l’écran 

d’affi chage du calendrier.
Le menu <Calendar> (Calendrier) apparaît. 

2. Appuyez sur <View Type> (Type d'affi chage).
L’écran <View Type> <Type d’affi chage> apparaît.

3. Appuyez sur l’icône [ ,  ] pour sélectionner le 
mode d’affi chage souhaité et appuyez sur <OK>.

Choisissez entre <Type 1> et <Type 2>.
<Type 1> permet un affi chage du dimanche au samedi 
alors que <Type 2> permet un affi chage du lundi au 
dimanche.

SUN MON TUE WEO THU    FRI SATAA

View Type

Type 1

OK Cancel

Prime Pack

Texts

Alarm

Calendar
World Clock
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AFFICHAGE DE L'HORLOGE UNIVERSELLE
Vous pouvez vérifi er l’emplacement et les date et heure des principales villes à 
travers le monde en vous basant sur leurs fuseaux horaires respectifs.

Avant de démarrer - Vous devez tout d’abord régler l’horloge. Voir page 31.
Réglez le fuseau horaire souhaité dans <Setting> (Paramètres) <Time> (Heure) 

<Time Zone> (Fuseau hr).

1. Appuyez légèrement sur l’icône  située sur l’écran 
du menu principal.

Le menu <Prime Pack> (Pack plus) apparaît. 

2. Sélectionnez <World Clock> (Horl. mond.) et appuyez 
dessus.

L’écran <World Clock> (Horl. mond.) apparaît.

3. Appuyez sur l’icône [ , ] pour sélectionner un fuseau 
horaire.

Vous pouvez affi cher les date et heure de la ville sélectionnée.

Vous pouvez vérifi er l’heure locale du fuseau horaire suivant.
(‘/’ indique le fuseau horaire standard de la région)
Cape Verde / London, Lisbon / Rome, Paris / Athens, Helsinki / Moscow, Riyadh / 
Abu Dhabi, Muskat / Tashkent, Ashgabat / Alma Ata, Kathmandu / Bangkok, Jakarta / 
Hong Kong, Beijing / Seoul, Tokyo / Guam, Sydney / Okhotsk / Wellingtons, Oakland / 
Samoa, Midway / Honolulu, Hawaii / Alyeska / Los Angeles, Seattle / 
Denver, Phoenix / Chicago, Mexico City / New York, Miami, / Caracas, Santiago / 
Buenos Aires, Brasilia / The middle Atlantic 

Prime Pack

Texts

Alarm

Calendar

World Clock
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utiliser la fonction bluetooth
Appuyez sur l’icône [ ] pour revenir à l’écran précédent.
Appuyez longuement sur l’icône [ ] pour accéder à l’écran du menu principal.

Qu'est-ce que la fonction Bluetooth ?
Bluetooth est une spécifi cation du secteur des télécommunications destinée aux 
réseaux personnels sans fi l. Cette solution vous permet de relier et d’échanger des 
informations entre des périphériques de type téléphones mobiles, ordinateurs portables, 
ordinateurs personnels, imprimantes, appareils photos numériques ou consoles de jeux 
vidéo via des fréquences radioélectriques de courte distance généralement de base.

Le périphérique Bluetooth peut engendrer du bruit ou créer des 
dysfonctionnements en fonction des conditions d'utilisation.

Des interférences au niveau de la couche physique ; par exemple, si vous tenez le lecteur 
à la main et portez des écouteurs dans les oreilles.
Si une partie du corps est en contact avec le système de réception/transmission du lecteur 
ou des écouteurs stéréo.
Variation électrique suite à un brouillage en raison de l’agencement du mur, de l'angle ou 
du bureau.
Interférence électrique provenant d'appareils utilisant la même bande de fréquences (ex. : 
appareils médicaux, fours à micro-ondes et réseaux LAN).

Lorsque vous associez le périphérique Bluetooth au lecteur, veillez à ce que la 
distance soit la plus courte possible.
Plus le lecteur est éloigné des écouteurs stéréo, moins la qualité est bonne. 
Si la distance excède la limite autorisée, la communication est coupée.
Il est déconseillé d’utiliser les modes d’affi chage texte ou image pendant que vous 
écoutez de la musique avec les écouteurs stéréo, car les performances du lecteur 
et les communications Bluetooth pourraient être altérées.
En fonction du modèle des écouteurs stéréo, les fi chiers de moins de 32 KHz ne 
peuvent pas être lus.
Il est possible que la connexion Bluetooth ne fonctionne pas correctement dans 
les zones où la réception est faible (ex. : ascenseur ou sous-sol).
La distance maximale permettant une connexion sans fi l entre le lecteur et le 
système Bluetooth est de 10 m. La connexion s’interrompt automatiquement 
lorsque cette plage est dépassée. Même si la distance est respectée, il est possible 
que la qualité sonore soit détériorée par des obstacles (ex. : murs, portes).

REMARQUE
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UTILISATION DES ECOUTEURS STEREO BLUETOOTH
Vous pouvez utiliser des écouteurs stéréo Bluetooth pour écouter de la musique 
avec un son stéréo de haute qualité, tout cela sans fi l !

Avant de démarrer -  Assurer vous que votre périphérique Bluetooth est prêt à être 
connecté (reportez-vous à son manuel d’utilisation).

Enregistrer les écouteurs stéréo Bluetooth
(un seul enregistrement suffi t)

1. Appuyez légèrement sur l’icône  située sur 
l’écran du menu principal.

La fenêtre de réglage Bluetooth apparaît.

2. Appuyez sur <Yes> (Oui).
La fonction <Bluetooth Mode> (Mode Bluetooth) est 
réglée sur <On> (Marche).
L’icône  s’allume.

3. Préparez les écouteurs stéréo en vue de 
l'association.

Pour préparer les écouteurs stéréo au mode 
d’association, reportez-vous au manuel d’utilisation 
des écouteurs.

4. Appuyez sur <Stereo Headset> (Écouteurs 
Stéréo).

5. Appuyez sur l'icône [ ].
Le lecteur recherche automatiquement l'appareil 
Bluetooth même si l'icône [ ] n'est pas actionnée.
Les écouteurs à enregistrer fi gurent dans la liste.

Bluetooth

Stereo Headset
Bluetooth Mode

Bluetooth Settings
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UTILISATION DES ECOUTEURS STEREO BLUETOOTH (Suite)
Enregistrer les écouteurs stéréo Bluetooth (Suite)
6. Appuyez sur le nom des écouteurs que vous souhaitez enregistrer.

La fenêtre de saisie du mot de passe s’affi che si le mot de passe des 
écouteurs est autre que 0000. Reportez-vous au manuel d’utilisation des 
écouteurs pour en savoir plus sur le mot de passe.
Les écouteurs sont enregistrés.

Vous pouvez utiliser la fonction Bluetooth pendant la lecture de fi chiers 
musicaux et vidéo uniquement. Cette fonction n’est pas prise en charge 
lorsque vous écoutez la radio FM.

Description des icônes Bluetooth
 : Activation du mode Bluetooth             : Relié à des écouteurs stéréo

Pour désactiver la fonction Bluetooth, réglez le mode Bluetooth sur 
<Bluetooth>  <Bluetooth Mode> (Mode Bluetooth)  <Off> (Arrêt).

Utilisez uniquement les casques stéréo certifi és Bluetooth. Les kits piéton 
mono ne sont pas pris en charge.

Lorsque vous n’utilisez pas le mode Bluetooth, réglez la fonction 
<Bluetooth Mode> (Mode Bluetooth) sur <Off> (Arrêt). Si la fonction 
<Bluetooth Mode> (Mode Bluetooth) reste réglée sur <On> (Marche), la 
durée de vie de la batterie diminue.

Vous pouvez ajouter jusqu’à 20 périphériques pour la connexion Bluetooth.

En fonction du modèle, il est possible que la communication avec certains 
écouteurs stéréo Bluetooth soit de mauvaise qualité.

REMARQUE
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UTILISATION DES ECOUTEURS STEREO BLUETOOTH (Suite)

Relier des écouteurs stéréo Bluetooth enregistrés

1. Appuyez légèrement sur l’icône  située sur 
l’écran du menu principal.

2. Appuyez sur <Stereo Headset> (Écouteurs 
Stéréo).

3. Appuyez sur les écouteurs stéréo à relier.
Une fois la connexion établie, [ ] l’icône s’affi che. 

Vous pouvez relier jusqu'à 2 jeux d’écouteurs.

4. Lancez la lecture du fi chier de votre choix.
Vous pouvez écouter de la musique à l'aide du casque 
stéréo.

Si vous ne trouvez pas le casque que vous souhaitez utiliser, procédez tout 
d'abord à son enregistrement.

Si vous éteignez puis allumez le lecteur ou le casque en l'espace d'une 
seconde, la communication Bluetooth est interrompue. Si vous souhaitez 
écouter de la musique à l'aide du casque stéréo, répétez les instructions 
ci-dessus.

Lorsque deux jeux d’écouteurs sont reliés, seul les écouteurs connectés 
en premier peuvent être activés lors de la lecture/l’arrêt et le contrôle du 
volume.
Pour de plus amples informations, reportez-vous au manuel d’utilisation 
des écouteurs.

REMARQUE

Stereo Headset

SBH100
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UTILISATION DU MENU BLUETOOTH

Déconnecter le périphérique Bluetooth

1. Appuyez légèrement sur l’icône  située sur 
l’écran du menu principal.

2. Appuyez sur l'icône [ ].
Le menu <Bluetooth> apparaît.

3. Appuyez sur <Disconnect> (Déconnecté).
La fenêtre de confi rmation de la déconnexion s’affi che.

4. Appuyez sur <Yes> (Oui).
Le périphérique actuellement connecté est 
déconnecté.

Vérifi er le périphérique Bluetooth connecté

1. Appuyez légèrement sur l’icône  située sur 
l’écran du menu principal.

2. Appuyez sur l'icône [ ].
Le menu <Bluetooth> apparaît.

3. Appuyez sur <Connected Device> (Périph. 
connecté).

Vous pouvez affi cher la liste des périphériques 
connectés.

Bluetooth

Stereo Headset
Bluetooth Mode

Bluetooth Settings

Disconnect

Connected Device

Bluetooth

Stereo Headset
Bluetooth Mode

Bluetooth Settings

Disconnect

Connected Device
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REGLAGES BLUETOOTH
Avant de démarrer - Réglez la fonction <Bluetooth Mode> (Mode Bluetooth) sur 

<On> (Marche).

1. Appuyez légèrement sur l’icône  située sur l’écran du 
menu principal.

2. Sélectionnez <Bluetooth Settings> (Paramètres 
Bluetooth) et appuyez dessus.

Le menu <Bluetooth Settings> (Paramètres Bluetooth) 
s’affi che.

3. Réglez les options souhaitées et appuyez sur <OK>.

Options de réglage Bluetooth
Search Timeout (Délai d’Attente Recherche Dépassé) : Vous permet de 
régler la durée de recherche d’un nouveau périphérique. Après la recherche 
de l’heure, la recherche d'un nouveau périphérique est lancée pour la durée 
défi nie. Choisissez entre <10sec>, <20sec>, <30sec>, <45sec> et <60sec>.
Delete Device (Supprimer le Périphérique) : Vous permet de supprimer un 
périphérique enregistré sur le lecteur. Appuyez sur l’icône [ ] pour supprimer 
tous les périphériques enregistrés. Reportez-vous à la page 93.
My Device Info. (Informations de Mon Périphérique) : Vous pouvez vérifi er le 
nom et l’adresse de votre lecteur.

Bluetooth

Stereo Headset

Bluetooth Mode

Bluetooth Settings
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REGLAGES BLUETOOTH (Suite)
Supprimer un périphérique Bluetooth

1. Sélectionnez <Delete Device> (Supprimer le 
Périphérique) et appuyez dessus.

La liste des périphériques enregistrés s'affi che.

2. Sélectionnez un périphérique à supprimer et 
appuyez sur l’icône [ ].

Appuyez sur l’icône [ ] pour supprimer tous les 
périphériques enregistrés.

3. Appuyez sur <Yes> (Oui).
Le périphérique sélectionné est supprimé.

Renommer un périphérique Bluetooth

1. Sélectionnez <My Device Info.> (Informations de 
Mon Périphérique) et appuyez dessus.

La fenêtre Informations de Mon périphérique s’affi che.
2. Appuyez sur l'icône [ ].

La fenêtre Edit Device Name (Modifi er le nom du 
périphérique) apparaît.

3. Renommez le périphérique en appuyant sur un 
chiffre ou sur l’icône représentant un caractère.

[1Aa] : Permet de passer du mode de saisie Chiffre au mode 
de saisie Lettres majuscules et minuscules Anglais.

[ ] : Permet de supprimer les caractères l’un après l’autre.
[ – ] : Permet d’ajouter un espace entre les caractères.
[OK] : Confi rmez votre modifi cation.
Ex. : pour saisir « YPS5 »
-Allez sur l’icône correspondante et appuyez dessus.

 (une fois) (trois fois) (une fois) (trois fois) 
(deux fois) (une fois)

1Aa

My Device Info.

Edit Device Name

Bluetooth Settings

Search Timeout

Delete Device
My Device lnfo.
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dépannage
Si vous rencontrez un problème avec votre nouveau lecteur MP3, des 
solutions vous sont proposées dans cette liste. Si le problème persiste, 
contactez le service clientèle Samsung le plus proche.

PROBLÈME SOLUTION

L’appareil ne s’allume 
pas.

• L’appareil ne s’allumera pas si la batterie est 
entièrement déchargée. Rechargez la batterie et 
remettez l’appareil sous tension.

• Appuyez sur le bouton de réinitialisation.

Les boutons ne 
fonctionnent pas.

• Vérifi ez si l’interrupteur est dirigé dans le 
sens de la fl èche. 

• Assurez-vous que vous appuyez sur le bouton et 
l'icône adéquats avant d'essayer.

• Appuyez sur le bouton de réinitialisation.

L’écran ne s’allume 
pas.

• Il se peut que les données affi chées à l’écran ne 
soient pas visibles sous les rayons directs du soleil.

• Lorsque <Display Off> (Affi ch. désactivé) est 
sélectionné dans <Settings> (Paramètres)
<Display> (Affi cher), l’écran tactile s’éteint. Appuyez 
sur un bouton ou sur l’écran et vérifi ez s’il s’allume.

L’alimentation est 
coupée.

• Vérifi ez l’état de charge de la batterie.
• L’alimentation se coupe automatiquement lorsque 

la batterie est entièrement déchargée. Rechargez la 
batterie.

• Si <Auto Power Off> (Extinction auto) est sélectionné 
dans <Settings> (Paramètres) <System> (Système),
l’alimentation est coupée lorsque le lecteur est en mode 
Pause. Allumez le lecteur.
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PROBLÈME SOLUTION

La durée de vie de 
la batterie diffère de 
celle indiquée dans le 
manuel.

• L’autonomie de la batterie peut varier en fonction du 
mode son utilisé et du réglage de l’affi chage.

• La durée de vie de la batterie peut être réduite si 
vous exposez le lecteur à des températures basses 
ou élevées pendant des périodes prolongées.

Dysfonctionnement du 
programme Samsung
Media Studio

• Vérifi ez que votre ordinateur dispose de la 
confi guration requise.

La connexion à 
l’ordinateur est 
interrompue.

• Assurez-vous que le câble USB est branché 
correctement et essayez à nouveau.

• Appuyez sur le menu <Démarrer> de la barre 
d’outil de votre ordinateur pour lancer la mise à 
jour Windows. Redémarrez votre ordinateur et 
rebranchez l’appareil.

Le taux de transfert du 
fi chier est trop lent.

• Si plusieurs programmes sont ouverts sur votre 
ordinateur (dont <Samsung Media Studio>), le 
taux de transfert du fi chier sera ralenti. Quittez les 
programmes que vous n’utilisez pas et procédez à 
nouveau au transfert.

Le lecteur ne
fonctionne pas.

• Vérifi ez que le fi chier disponible a bien été 
enregistré dans la mémoire.

• Assurez-vous que le fi chier musical n’est pas 
endommagé.

• Vérifi ez que la puissance de la batterie est 
suffi sante.



96 _ dépannage

PROBLÈME SOLUTION

Les fi chiers ne se 
téléchargent pas.

• Vérifi ez que le câble USB est correctement 
branché. Rebranchez-le au besoin.

• Assurez-vous qu’il reste de l’espace disponible sur 
la mémoire.

• Appuyez sur le bouton de réinitialisation.

Des fi chiers ou des 
données manquent.

• Vérifi ez que le câble USB n’a pas été débranché 
durant le transfert du fi chier ou des données. Si 
tel est le cas, les fi chiers/données mais également 
l’appareil risquent d’être endommagés. Vous devez 
faire preuve d’une extrême prudence à cet égard 
car Samsung ne saurait en aucun cas être tenu 
responsable de la perte des données.

Affi chage anormal de la 
durée de lecture.

• Vérifi ez que le fi chier est au format VBR (débit 
binaire variable).

Affi chage anormal du 
nom de fi chier.

• Allez dans <Settings> (Paramètres) <Language>
(Langue) <Contents> (Sommaire) depuis le Menu 
principal et défi nissez la langue qui vous convient.

L’appareil est chaud.
• Les phases de chargement peuvent générer de la 

chaleur. Cela n’a aucune incidence sur la durée de 
vie de l’appareil ou sur son fonctionnement.

Un message s’affi che 
pendant le visionnage 
d’une vidéo

• Essayez à nouveau de télécharger le clip vidéo en 
passant par le logiciel Samsung Media Studio.

La connexion Bluetooth 
ne fonctionne pas

• Vérifi ez que les écouteurs stéréo sont certifi és Bluetooth. 
Les kits Mains libres mono ne sont pas pris en charge.

• La connexion Bluetooth peut être désactivée si vous 
éteignez et rallumez le lecteur ou les écouteurs 
stéréo. Dans ce cas, essayez de vous reconnecter.
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annexe
ARBORESCENCE DES MENUS
Voici une rapide présentation de la façon dont les menus et les fonctions sont 
organisés dans votre nouveau lecteur MP3.

Ecran de sélection du menu

Videos Music Pictures FM
Radio Datacasts Prime

Pack
File

Browser Bluetooth Settings

Texts Stereo
Headset Menu Style

Alarm Bluetooth
Mode Sound

Calendar Bluetooth
Settings Display

World Clock Language

Time

System
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CARACTÉRISTIQUES DU PRODUIT

Nom du modèle YP-P2
Puissance nominale 5,0 V CC / 500 mA
Alimentation de la 
batterie intégrée 830 mAh / 3,7 V CC

Fichier Compatibilité

AUDIO  : MPEG1/2/2.5 Couche 3 (8 kbps à 320 
kbps, 8 kHz à 48 kHz), WMA (8 kbps à 320 
kbps, 8 kHz à 48 kHz)

VIDEO : SVI (vidéo : MPEG4, Audio : MP3 (44,1 kHz 
16 bit Stéréo, 128 kbps), 
Résolution : 480 x 272, Vitesse 
d’enregistrement : 30 fps) WMV9 (Vidéo 
: WMV9 Profi l simple, Audio :WMA9 (860 
kbps maxi.), 
Résolution : 320 x 240 ou 480 x 272, 
Vitesse d’enregistrement : 30 fps)

IMAGE : JPG (ligne de base uniquement)
Sortie des écouteurs 20mW/CH(France 5mW/CH) (16 )
Bande de fréquences 
de la sortie 20Hz à 20KHz

Rapport signal-bruit 89 dB avec fi ltre passe bas 20 kHz (sur la base de 1 KHz, 0 dB)

Durée de lecture
Jusqu’à 35 heures de lecture musicale (sur la 
base de : MP3 128 kbps, Volume 20, Mode sonore 
normal), jusqu’à 5 heures de lecture vidéo

Plage de températures 
de fonctionnement -5~35°C (23~95°F)

Etui PMMA, Inoxydable
Poids 86 g
Dimensions (L x H x P) 52 X 100 X 9,95 mm
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Radio FM
Fréquence FM 87.5~108.0MHz T.H.D. FM 0.8%

Rapport signal 
FM 59 dB Sensibilité

FM utile 5dB

Système sans fi l
Type d’émission F1D
Puissance RF 2,4mW
Fréquence d’émission 2 402 à 2 480 MHz
Fréquence de réception 2 402 à 2 480 MHz
Nombre de canaux 79 ch
Température -10°C à +50°C
Système de modulation GFSK
Mode de communication bidirectionnel non simultané
Humidité 95%
Spec Version Supported 2.0
Module BCM2048

Le contenu de ce manuel est susceptible d’être modifi é en vue d’être amélioré 
sans notifi cation préalable.
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LICENCE
L’unité qui se trouve avec ce manuel de l’utilisateur est fournie sous licence sous 
certains droits de propriété intellectuelle de parties tierces. Cette licence est limitée 
à une utilisation privée non commerciale par l’utilisateur fi nal pour les contenus sous 
licence.
Aucun droit n’est concédé pour une utilisation commerciale.
Cette licence ne couvre aucun produit autre que celui-ci et ne peut être étendue à 
un produit ou processus qui n’est pas sous licence selon la norme ISO/IEC 11172-3 
ou ISO/IEC 13818-3 utilisé ou vendu avec ce produit.
La licence couvre uniquement l’utilisation de ce produit pour encoder et/ou décoder 
des fi chiers audio selon la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3. Aucun droit 
n’est cédé sous cette licence pour des caractéristiques ou des fonctions du produit 
qui ne sont pas conformes à la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.

Ce symbole sur le produit ou sa documentation indique qu’il 
ne doit pas être éliminé en fi n de vie avec les autres déchets 
ménagers. L’élimination incontrôlée des déchets pouvant 
porter préjudice à l’environnement ou à la santé humaine, 
veuillez le séparer des autres types de déchets et le recycler 
de façon responsable. Vous favoriserez ainsi la réutilisation 
durable des ressources matérielles.
Les particuliers sont invités à contacter le distributeur 
leur ayant vendu le produit ou à se renseigner auprès 
de leur mairie pour savoir où et comment ils peuvent se 
débarrasser de ce produit afi n qu’il soit recyclé en respectant 
l’environnement.
Les entreprises sont invitées à contacter leurs fournisseurs et 
à consulter les conditions de leur contrat de vente. Ce produit 
ne doit pas être éliminé avec les autres déchets commerciaux.
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